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kenmerken van uw nieuwe MP3-speler
Mooi. Intelligent. Betrouwbaar. En vooral leuk! Dat is uw nieuwe MP3-speler, 
en nog veel meer. De ultramoderne technologie zorgt voor een krachtig 
geluid en heldere beelden. U zult heel veel plezier beleven aan uw nieuwe 
MP3-speler, of u nu aan het sporten bent, uw favoriete nummers downloadt, 
video’s bekijkt of gewoon naar de radio luistert.
Nadat u hem eenmaal het gebruikt, vraagt u zich af hoe u ooit zonder hebt 
gekund.
MEER MULTI IN MULTIMEDIA
We noemen het een MP3-speler, maar het 
is veel meer dan dat. U kunt afbeeldingen, 
tekst en video’s bekijken en naar FM-radio 
luisteren.
De ingebouwde draadloze Bluetooth-
technologie verandert uw MP3-speler in uw 
eigen persoonlijke netwerk.

AANRAAKBEDIENING
Door licht op het aanraakscherm te tikken 
kunt u door de menu’s bladeren.

LCD-KLEURENSCHERM
Op het brede LCD-scherm worden heldere 
kleuren en beelden weergegeven.

WAAR VORM EN FUNCTIONALITEIT 
HAND IN HAND GAAN
Jazeker, hij is gestroomlijnd en mooi. Maar 
hij ligt ook lekker in de hand en is eenvoudig 
te bedienen.

EENVOUDIG ZOEKEN
U kunt zoeken naar bestanden met de 
eenvoudig te gebruiken Bestandsbrowser. 
Bovendien kunt u door menu’s navigeren 
terwijl u naar muziek luistert.

LANGERE AFSPEELDUUR EN KORTERE 
DOWNLOADTIJD
Met een volledig geladen batterij kan 
maximaal 35 uur muziek en 5 uur video 
worden afgespeeld.
Het downloaden gaat sneller. Dankzij de 
compatibiliteit met USB 2.0 is de speler veel 
sneller dan modellen met USB 1.1.

WONDER VAN GELUIDSKWALITEIT
Uw nieuwe MP3-speler is uitgerust met 
DNSe™ (Digital Natural Sound-engine), 
de unieke geluidstechnologie van Samsung 
voor een rijker, dieper geluid en een 
ongelofelijke luisterbeleving.



veiligheidsinformatie
Betekenis van de pictogrammen en aanduidingen in deze gebruiksaanwijzing:

WAARSCHUWING

Risico van lichamelijk letsel met mogelijk fatale 
gevolgen.

LET OP
Risico van lichamelijk letsel of materiële schade.

LET OP

U kunt het risico op brand, ontploffi ng, elektrische schokken of 
lichamelijk letsel tijdens het gebruik van uw MP3-speler verminderen 
door de genoemde belangrijke voorzorgsmaatregelen in acht te nemen.

OPMERKING

Tips of verwijzingen naar informatie die u kunnen helpen 
bij het bedienen van de speler.

NIET proberen.

NIET demonteren.

NIET aanraken.

Volg de aanwijzingen nauwgezet op.

Haal de stekker uit het stopcontact.

Bel het servicecentrum voor assistentie.

Deze waarschuwingstekens dienen om persoonlijk letsel, van uzelf en van 
anderen, te voorkomen.
Voer de aanwijzingen nauwgezet op.
Bewaar de gebruiksaanwijzing nadat u dit gedeelte hebt doorgelezen op een 
veilige plaats, zodat u deze informatie later nog eens kunt naslaan. 



veiligheidsinformatie
In deze gebruiksaanwijzing wordt het juiste gebruik van uw nieuwe 
MP3-speler beschreven. Lees de gebruiksaanwijzing zorgvuldig door 
om te voorkomen dat u de speler beschadigt of uzelf verwondt.
Let met name op de volgende serieuze waarschuwingen:

BESCHERM UZELF
Demonteer, repareer of wijzig het product niet zelf.

Zorg dat het product niet nat wordt. Het product is niet waterbestendig. 
Als het product nat wordt, schakel het dan niet in. Anders zou u een 
elektrische schok kunnen krijgen. Neem in dat geval contact op met het 
dichtstbijzijnde Samsung Service Center.

Gebruik het product niet tijdens een onweer met bliksem. Anders loopt u 
het risico op storingen of elektrische schok.

Gebruik de oordopjes niet als u op een fi ets zit of een auto of motor 
bestuurt.
Dit kan een ernstig ongeluk veroorzaken. Het is bovendien in enkele landen bij wet 
verboden.
Gebruik van de oortelefoon tijdens het lopen en joggen op de openbare weg, met 
name tijdens het oversteken, kan leiden tot ernstige ongelukken.

Let er tijdens het sporten of wandelen omwille van de veiligheid op dat 
de kabel van de oortelefoon niet achter uw arm of een object in uw 
omgeving kan blijven haken.

Plaats het product niet in een vochtige, stoffi ge of vuile omgeving. Anders 
zou brand kunnen ontstaan of loopt u het risico op een elektrische schok.

LET OP

WAARSCHUWING

LET OP



BESCHERM UZELF
Het gebruik van oortelefoon of hoofdtelefoon gedurende langere tijd kan 
leiden tot ernstige gehoorbeschadiging.
Blootstelling voor langere tijd aan een geluidsniveau van meer dan 85 dB kan uw 
gehoor nadelig beïnvloeden. Hoe hoger het geluidsniveau, des te ernstiger de 
mogelijke gehoorschade. (Een normaal gesprek vindt plaats op een niveau van 50 
tot 60 dB. Het geluidsniveau op de weg is ongeveer 80 dB.) U wordt uitdrukkelijk 
aanbevolen het volumeniveau op medium te zetten. (Medium is doorgaans minder 
dan 2/3 van het maximum.)
Als u een piep in uw oren ervaart, moet u het volume verlagen of het 
gebruik van oortelefoon of hoofdtelefoon staken.

UW MP3-SPELER BESCHERMEN
Bewaar of gebruik de speler niet bij temperaturen boven 35°C 
(bijvoorbeeld een sauna of in een geparkeerde auto).
Zorg dat u de speler nergens tegen stoot en laat de speler niet vallen.
Plaats geen zware voorwerpen op de speler.
Voorkom dat externe deeltjes of stof in het product komen.
Plaats het product niet in de buurt van magnetische objecten.
Zorg dat u een reservekopie van belangrijke gegevens maakt. Samsung is 
niet aansprakelijk voor verlies van gegevens.
Gebruik uitsluitend door Samsung geleverde of goedgekeurde 
accessoires.
Spuit geen water op het product. Maak het product niet schoon met 
chemicaliën als benzeen of thinner. Hierdoor kan er brand ontstaan, kunt 
u een elektrische schok krijgen en kan het oppervlak beschadigd raken.
Het niet opvolgen van deze instructies kan tot lichamelijk letsel leiden of 
schade aan de speler veroorzaken.

Als u deze gebruiksaanwijzing wilt afdrukken, adviseren we u dat u deze in 
kleur afdrukt en de optie “Aan pagina aanpassen” in de afdrukopties selecteert 
voor een betere weergave.

LET OP

OPMERKING

WAARSCHUWING

LET OP



inhoud
BASISINFORMATIE

10
10 Inhoud van de verpakking
11 Uw MP3-speler
13 Schermen
17 Werken met het aanraakscherm
21 De batterij opladen
22 Onderhoud van de batterij
22 De speler in- en uitschakelen
23 Een videobestand afspelen
23 Het volume regelen
24 De toetsen vergrendelen
25 Bestanden zoeken met “File 

Browser” (Bestandsbrowser)
25 Bestanden verwijderen met “File 

Browser” (Bestandsbrowser)
26 Instellingen en voorkeuren wijzigen
26 Instellingen voor menustijl
29 Geluidsinstellingen
30 Weergave-instellingen
31 Taalinstellingen
33 Tijdinstellingen
34 Systeeminstellingen
38 De mp3-speler resetten

EMODIO

39
39  Systeemvereisten
40 EmoDio installeren
41 Bestanden overbrengen naar de 

speler met EmoDio



inhoud
EEN VIDEO BEKIJKEN

44
44 Pauzeren
45 Naar een specifi ek frame gaan
46 Het vorige videobestand afspelen
46 Het volgende videobestand afspelen
47 Het videomenu gebruiken

MUZIEK
BELUISTEREN

54
54 Luisteren op categorie
56 Pauzeren
56 Afspelen vanaf het begin van het 

huidige nummer
56 Het vorige nummer afspelen
57 Het volgende nummer afspelen
57 Zoeken binnen een nummer
58 Een fragment herhaald afspelen
59 De albumhoes en de albumgegevens 

tegelijkertijd weergeven
60 Een afspeellijst maken met EmoDio
60 Een afspeellijst maken
61 Muziekbestanden toevoegen aan een 

afspeellijst die u hebt gemaakt
62 Een afspeellijst naar de speler 

overbrengen met EmoDio
63 Een afspeellijst op uw mp3-speler 

maken
64 Een afspeellijst afspelen
65 Een bestand verwijderen uit de 

afspeellijst
65 Alle bestanden verwijderen uit de 

afspeellijst
66 Het muziekmenu gebruiken



DE DATACAST 
GEBRUIKEN

90
90 Een kanaal registreren
91 Een nieuwe kanaalgroep maken
91 Een datacast overbrengen van 

<EmoDio>
92 Datacasts weergeven

HET HOOFDPAKKET 
GEBRUIKEN

93
93 Tekst lezen
94 Het tekstmenu gebruiken
98 Videospelletjes spelen
102 Het alarm instellen
105 De agenda bekijken
106 Het adresboek bekijken
107 De wereldklok weergeven
108 De rekenmachine gebruiken
109 Stemopname
111 Wereldkaart metro weergeven

inhoud
AFBEELDINGEN BEKIJKEN

76
76 Naar de vorige/volgende afbeelding gaan
77 Het afbeeldingsmenu gebruiken

R DE FM-RADIO LUISTEREN

82
82 De dempfunctie gebruiken
83 FM-Stations zoeken
84 het menu FM-radio gebruiken



inhoud

PROBLEMEN
OPLOSSEN

130
130 Problemen oplossen

BLUETOOTH 
GEBRUIKEN

112
112  Wat is Bluetooth?
113  Een Bluetooth-stereokoptelefoon 

gebruiken
116  Een mobiele telefoon met Bluetooth 

gebruiken
122 Bestanden overbrengen naar/van een 

Bluetooth-apparaat
127 Het Bluetooth-menu gebruiken
128 Bluetooth-instellingen

BIJLAGE

133
133 Overzicht van menuopties
134 Productspecifi caties
136 Licentie



10 _ basisinformatie

basisinformatie
INHOUD VAN DE VERPAKKING
Bij uw nieuwe MP3-speler worden de volgende accessoires geleverd. Als een van 
deze items ontbreekt, moet u contact opnemen met de klantenservice van Samsung.

Speler Oortelefoon USB-kabel Installatie-
cd

Easy
Holder

Beschermde
laag LCD

Het ontwerp van de accessoires kan ter verbetering van het product zonder 
voorafgaande kennisgeving worden gewijzigd.

De Easy Holder gebruiken
Plaats de speller op de Easy holder op een plat oppervlak. Op deze 
manier kunt u video’s bekijken zonder de speler vast te houden.

Het is geen vaste houder, dus schud er niet mee.
OPMERKING
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UW MP3-SPELER

Aanraakscherm

Aan/uit-lampje
Het aan/uit-lampje is rood als 
de batterij wordt opgeladen. Als 
de batterij volledig is opgeladen, 
wordt het lampje groen.

 Toets Volume omhoog
Indrukken om het volume te verhogen

 Toets Volume omlaag
Indrukken om het volume te verlagen

Resetopening
Als er een storing in 
de speler optreedt, 
drukt u met een 
puntig voorwerp in de 
resetopening om het 
systeem opnieuw te 
initialiseren.

Haak van de Easy Holder
De lus van de Easy Holder bevestigen
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UW MP3-SPELER (vervolg)

Schakelaar Hold (Vergrendelen) 
Indrukken in de richting van de pijl om de 
functietoetsen te vergrendelen.

Toets Aan/Uit en Afspelen/Pauze 
Indrukken voor afspelen/pauze.
Iets langer indrukken om het apparaat in of 
uit te schakelen.

Oortelefoonaansluiting

Oortelefoon
Op het linkerdopje 
ziet u een 
“L” en op het 
rechterdopje een 
“R”. Fungeert 
tevens als 
antenne voor de 
FM-radio in de 
MP3-speler.USB-aansluiting

Microfoon
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SCHERMEN
Video

1
Bluetooth/Vergrendeling/
Alarmindicator 7 Afspelen/pauze, zoeken

2 Batterijstatus 8 Indicator videomodus

3 Huidige tijd 9 Statusbalk afspelen

4 Huidige/totale afspeeltijd 10 Pictogram Vorige

5 Bestandsnaam 11 Pictogram Menu

6
Pictogram Afspelen/pauze, 
Zoeken

De schermafbeeldingen dienen slechts ter illustratie. Het scherm kan er in 
werkelijkheid anders uitzien.
Informatie en pictogrammen verdwijnen na enige tijd bij het afspelen van 
video’s. Tik op het scherm als u deze informatie en pictogrammen weer wilt 
weergeven.

OPMERKING

Video Track 1

11
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SCHERMEN (vervolg)
Muziek

1
Bluetooth/Vergrendeling/
Alarmindicator

2 Huidige tijd

3 Batterijstatus

4
Indicator huidig nummer / 
totaal aantal nummers

5 Muziekafspeelscherm

6 Statusbalk afspelen

7 Huidige/totale afspeeltijd

8
Pictogram Afspelen/pauze, 
Zoeken

9 Pictogram A-B herhalen

10 Afspelen/pauze, zoeken

11 Indicator muziekmodus

12 Indicator hoofdmenu

13 Titel

14 Indicator DNSe-modus

15 Indicator afspeelmodus

16 Pictogram Vorige

17 Pictogram Menu

Songs 1/52

5

11

3

4

1

2
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916
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15

14

13

Rising Sun
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SCHERMEN (vervolg)
Afbeelding

1
Bluetooth/Vergrendeling/
Alarmindicator

2 Huidige tijd

3 Batterijstatus

4 Indicator huidig bestand/totaal 
aantal bestanden

5 Pictogram Volgende afbeelding

6 Pictogram Zoom

7 Afspeelstatus muziek

8 Indicator Afbeeldingsmodus

9 Bestandsnaam

10 Pictogram Vorige afbeelding

11 Pictogram Vorige

12 Pictogram Menu

Informatie en pictogrammen verdwijnen na enige tijd bij het weergeven van 
afbeeldingen. Tik op het scherm als u deze informatie en pictogrammen 
weer wilt weergeven.

OPMERKING

[Afbeeldingsweergavescherm]

Photo image 1 2/8
3

4

1

2
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611

12
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SCHERMEN (vervolg)
FM-radio

1
Bluetooth/Vergrendeling/
Alarmindicator

2 Huidige tijd

3 Batterijstatus

4 Handmatig/voorkeuze

5 RDS-indicator

6
Pictogram
Voorgeprogrammeerd nummer

7 Indicator radiomodus

8 Huidige frequentie (MHz)

9 Frequentielocatie

10 Pictogram Menu

11 Pictogram Vorige

Pictogram Opnemen

Wat is RDS?
RDS (Radio Data System (Radiogegevenssysteem)) verzorgt de ontvangst en 
weergave van berichten zoals uitzendinformatie. 
De programmagegevens zoals News (Nieuws), Sports (Sport) of Music (Muziek), of 
informatie over het zendstation worden weergegeven op het display.
Als het FM-signaal zwak is, worden de RDS-gegevens mogelijk niet weergegeven.

OPMERKING

FM Radio
3

1

2

6
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7
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WERKEN MET HET AANRAAKSCHERM
Tik met uw vingertop op het aanraakscherm.

Gebruik geen kracht bij het aanraken van het scherm. Dit kan het scherm 
beschadigen.
Gebruik geen andere voorwerpen dan uw vingers om op het scherm te tikken. 
Anders zou het aanraakscherm kunnen beschadigen.
Tik niet op het aanraakscherm met vuile vingers.
Tik niet op het aanraakscherm met handschoenen aan.
Het aanraakscherm werkt mogelijk niet goed als u bijvoorbeeld uw vingernagel of 
een balpen gebruikt.

OPMERKING
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WERKEN MET HET AANRAAKSCHERM (vervolg)
U kunt in vier richtingen op het scherm tikken; omhoog, omlaag, links en rechts, 
afhankelijk van de functie
Voorbeeld: afspeelstatusbalk

Instructie 1
Plaats uw vinger op de afspeelstatusbalk 
op het scherm, beweeg uw vinger naar een 
gewenst punt en haal uw vinger van het 
scherm.

De speler gaat verder met afspelen vanaf het punt 
waar u uw vinger van het scherm hebt gehaald.

Instructie 2
Tik op een gewenst punt in de afspeelstatusbalk.
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WERKEN MET HET AANRAAKSCHERM (vervolg)
Voorbeeld: ingezoomde afbeelding

Instructie 3
Plaats uw vinger op het scherm, beweeg uw vinger in de gewenste 
richting en haal uw vinger van het scherm, zoals weergegeven in 
onderstaande afbeelding.

Beweeg uw vinger in de zoommodus in de gewenste richting. 
De afbeelding wordt verplaatst en weergegeven in de nieuwe positie.
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WERKEN MET HET AANRAAKSCHERM (vervolg)
Voorbeeld: het volgende/vorige videobestand afspelen

Instructie 4
Beweeg uw vinger naar links of rechts.

Links : u gaat naar het volgende bestand (afhankelijk van de instelling voor 
horizontale slag. (Zie pagina 52.)

Rechts : u gaat naar het vorige bestand (afhankelijk van de instelling voor 
horizontale slag. (Zie pagina 52.)

Video Track 1
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DE BATTERIJ OPLADEN
Laad de speler op voordat u deze voor het eerst gebruikt en wanneer u deze 
lange tijd niet hebt gebruikt.
Het volledig opladen van de batterij van de MP3-speler duurt ongeveer 
vier en een half uur. De oplaadtijd kan echter variëren, afhankelijk van uw 
computeromgeving.

1. Sluit het grootste uiteinde van de USB-kabel aan op de USB-aansluiting aan 
de onderkant van de speler.

2. Sluit de USB-kabel aan op de USB-poort ( ) van de computer.
Het aan/uit-lampje is rood als de batterij wordt opgeladen. Als de batterij volledig is 
opgeladen, wordt het lampje groen.

1

2

Aan/uit-lampje
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ONDERHOUD VAN DE BATTERIJ
De batterij gaat langer mee als u de volgende eenvoudige aanwijzingen voor 
het gebruik en de opslag ervan opvolgt.
• Opladen en bewaren bij een temperatuur tussen 5°C en 35°C.
• De batterij niet te lang opladen (niet langer 12 uur). 

Overmatig opladen of ontladen kan de levensduur van de batterij verkorten. 
• Aangezien een batterij een verbruiksartikel is, neemt de levensduur van de 

batterij na verloop van tijd geleidelijk af.
Als u de speler oplaadt door deze aan te sluiten op een draagbare computer, 
controleer dan eerst of de batterij van de draagbare computer zelf volledig is 
opgeladen of de draagbare computer is aangesloten op het lichtnet.
De oplaadbare accu in dit product kan niet door de gebruiker zelf worden 
vervangen. Neem contact op met uw serviceprovider voor informatie over 
vervanging.
De oplaadbare accu in dit product kan niet door de gebruiker zelf worden vervangen. 
Neem contact op met uw serviceprovider voor informatie over vervanging.

DE SPELER IN- EN UITSCHAKELEN
De speler inschakelen
Houdt de toets enige tijd ingedrukt.

De speler wordt ingeschakeld.

De speler uitschakelen
Houdt de toets enige tijd ingedrukt.

De speler wordt uitgeschakeld.

Het toestel wordt automatisch uitgeschakeld als gedurende 
een bepaalde tijd geen toetsen worden ingedrukt in de 
stopstand. De fabrieksinstelling voor <Auto Power Off> 
(Autom. uitschakelen) is 1 minuut, maar u kunt deze tijd zelf 
wijzigen. Zie pagina 34 voor meer informatie.
Zie pagina 27 voor het gebruik van <Cosmos> in het hoofdmenu.

LET OP

OPMERKING

OPMERKING
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EEN VIDEOBESTAND AFSPELEN
Kopieer videobestanden naar uw nieuwe MP3-speler met EmoDio.
Zie pagina 41 voor meer informatie over EmoDio.
1. Tik op het pictogram  in het hoofdmenu.

De lijst met video’s wordt weergegeven.

2. Selecteer een af te spelen videobestand en tik 
erop.

Het geselecteerde videobestand wordt horizontaal 
afgespeeld.

Druk op het pictogram [ ] om naar het vorige scherm te gaan.
Houd het pictogram [ ] enige tijd ingedrukt om het hoofdmenu weer te geven.

HET VOLUME REGELEN
U kunt het volume aanpassen als een bestand is gestopt of tijdens het afspelen.

Instructie 1
Druk op de toets  , .

De volumebalk wordt weergegeven. 
Het volumebereik is ingesteld van 0 tot 30.
Druk op de toets  om het volume te 
verhogen of op de toets om het te 
verlagen.

Instructie 2
Beweeg uw vinger omhoog of omlaag 
rechts in het midden van het scherm.

De volumebalk wordt weergegeven.
Als u uw vinger omhoog beweegt, wordt het 
volume verhoogd en als u uw vinger omlaag 
beweegt, wordt het volume verlaagd.

OPMERKING
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DE TOETSEN VERGRENDELEN
Met de vergrendelfunctie kunt u alle andere toetsen en pictogrammen op de 
MP3-speler vergrendelen, zodat uw muziek niet wordt onderbroken wanneer 
een van de toetsen, bijvoorbeeld tijdens het sporten, per ongeluk wordt 
ingedrukt.
1. Duw de schakelaar in de richting van 

de pijl.
2. Schuif de schakelaar in de 

tegenovergestelde richting van de pijl om de 
vergrendelfunctie uit te schakelen.

Als <Touch Screen Only> (Alleen aanraakscherm) is geselecteerd in <Settings> 
(Instellingen)  <System> (Systeem)  <Hold Option> (Optie Vergrendelen), wordt 
alleen het aanraakscherm vergrendeld en kunnen de knoppen  ,  en 

 gewoon worden gebruikt. Zie pagina 35.

OPMERKING
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BESTANDEN ZOEKEN MET “File Browser” 
(Bestandsbrowser)
U kunt eenvoudig bestanden zoeken met de functie <File Browser>
(Bestandsbrowser).
1. Tik op het pictogram  in het hoofdmenu.

De map <File Browser> (Bestandsbrowser) wordt weergegeven. 
Deze bevat Video, Music (Muziek), Playlists, Pictures 
(Afbeeldingen), Datecasts, Texts (Teksten), Games (Spel),
Received Files (Ontvangen bestanden), My Pack (Mijn pakket) en 
Recorded Files (Opgenomen bestanden).

2. Selecteer de gewenste map.
3. Tik op de geselecteerde map om de bestandslijst weer te 

geven.
Druk op het pictogram [ ] om naar het vorige scherm te gaan.

4. Selecteer het gewenste bestand.
5. Tik op het geselecteerde bestand.

Het bestand wordt afgespeeld.
De map <My Pack> (Mijn pakket) in de map <File Browser> (Bestandsbrowser) 
bevat myDNSe- of UCI-fi les die zijn overgebracht via <EmoDio>. Zie <EmoDio> 
voor meer informatie over myDNSe en UCI.

BESTANDEN VERWIJDEREN MET “FILE BROWSER” 
(BESTANDSBROWSER)
Volg stap 1 tot en met 4 hierboven.
5. Tik op het pictogram [ ].

Het bevestigingsvenster voor verwijderen wordt weergegeven.
6. Tik op <Yes> (Ja).

Het geselecteerde bestand is gewist.
Het geselecteerde bestand kan niet worden verwijderd als deze wordt afgespeeld.

Bestanden kunnen niet meer worden hersteld nadat ze zijn verwijderd.

OPMERKING

OPMERKING

LET OP

Video
Music

Playlists

Pictures

Datacasts

Texts

Games

Received Files

File Browser 1/8
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INSTELLINGEN EN VOORKEUREN WIJZIGEN
De instellingen en voorkeuren van de MP3-speler zijn in de fabriek ingesteld, 
maar u kunt deze voorgeprogrammeerde waarden zelf aan uw persoonlijke 
voorkeuren aanpassen.

Druk op het pictogram [ ] om naar het vorige scherm te gaan.
Houd het pictogram [ ] enige tijd ingedrukt om het hoofdmenu weer te geven.

Instellingen voor menustijl
U kunt het uiterlijk van het menu wijzigen en 
de achtergrondafbeelding van het hoofdmenu 
verwijderen.
1. Tik op het pictogram  in het hoofdmenu.

Het menu <Settings> (Instellingen) wordt weergegeven.
2. Selecteer <Menu Style> (Menustijl) en tik erop.

Het menu <Menu Style> (Menustijl) wordt weergegeven.
3. Tik op een gewenst menu.
4. Stel uw voorkeuren in en tik op <OK>.

Instellingsopties voor menustijl 
Menu Design (Menuontwerp) : U kunt de stijl van het hoofdmenu wijzigen. 
Maak een keuze uit <Cosmos>, <Matrix>, <My Skin> (Mijn huid), <Dandy_
Cosmos>, <Dandy_Matrix>, <Dandy_MySkin>, <Sammy_Matrix>, <Toy_
Cosmos>, <Toy_Matrix>, <Toy_MySkin>, <Woody_Cosmos>, <Woody_Matrix> 
en <Woody_MySkin>. Zie pagina 27~28.
Font (Lettertype) : U kunt het lettertype van de menutaal wijzigen. Kies één 
van de drie lettertypes. Voor sommige talen wordt <Font> (Lettertype) niet 
weergegeven in het menu.
Reset My Skin (Mijn huid opnieuw instellen) : Stelt de achtergrondafbeelding 
van het aanraakscherm in op de standaardafbeelding.

Als u in het scherm <Settings> (Instellingen) gedurende 1 minuut geen 
toetsen indrukt, gaan de instellingen die u nog niet hebt opgeslagen 
verloren en keert de speler terug naar de voorgaande functie.
De UCI-bestanden die zijn overgebracht met <EmoDio> staan in <Menu 
Design> (Menuontwerp). Zie <EmoDio> voor meer informatie over UCI.

OPMERKING
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Het menu Cosmos gebruiken
Instructie 1
Plaats uw vinger op het aanraakscherm en beweeg uw vinger omhoog of 
omlaag. Tik op het pictogram van het gewenste hoofdmenu.

Instructie 2
Plaats uw vinger op een lege ruimte van het aanraakscherm en 
beschrijf met uw vinger voorzichtig een cirkel. 
Tik op het pictogram van het gewenste hoofdmenu.

Het menu <Cosmos>
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Het menu Matrix gebruiken
Tik op het pictogram van het gewenste hoofdmenu.

Het menu Mijn Skin gebruiken
Plaats uw vinger op het aanraakscherm en blader naar links of rechts 
door uw vingertop in de gewenste richting te bewegen en van het 
scherm te halen. Tik op het pictogram van het gewenste hoofdmenu.

Het menu <Matrix>

Het menu <My Skin> (Mijn huid)
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Geluidsinstellingen
U kunt de hoofd-EQ, de pieptoon en de volumegrens instellen.
1. Tik op het pictogram  in het hoofdmenu.

Het menu <Settings> (Instellingen) wordt weergegeven.

2. Selecteer <Sound> (Geluid) en tik erop.
Het menu <Sound> (Geluid) wordt weergegeven.

3. Tik op een gewenst menu.
4. Stel uw voorkeuren in en tik op <OK>.

Opties voor geluidsinstellingen 
Master EQ (Hoofd-EQ) : U kunt de geluidsinstellingen optimaliseren. Tik op het 
pictogram [ , ] om de frequentie die u wilt aanpassen, te selecteren. 
De frequenties die kunnen worden aangepast, zijn <60Hz>, <150Hz>, <400Hz>, 
<1.1kHz>, <3.5kHz>, <8kHz> en <14kHz>. Tik op het pictogram [ , ] om het 
niveau van de geselecteerde frequentie aan te passen en tik op <OK>.
Beep Sound (Piepgeluid) : Het geluidssignaal voor de bediening van het 
aanraakscherm inschakelen of uitschakelen. U kunt kiezen tussen <Off> (Uit) 
en <On> (Aan).
Volume Limit (Volume grens) : U kunt gehoorbeschadiging bij gebruik van de 
koptelefoon voorkomen door een volumegrens in te stellen. Als de volumegrens 
is ingeschakeld, is het maximumvolume 15. 
Als de volumegrens is uitgeschakeld, is het maximumvolume 30.
Als u <Off> (Uit) selecteert, wordt het volume teruggezet naar 15 om schade 
aan uw gehoor te voorkomen wanneer u de speler weer inschakelt.

U kunt de <Master EQ> (Hoofd-EQ) niet instellen als de speler is 
verbonden met de Bluetooth-stereokoptelefoon.OPMERKING
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Weergave-instellingen
De uitschakeltijd en helderheid van uw scherm wijzigen.
1. Tik op het pictogram  in het hoofdmenu.

Het menu <Settings> (Instellingen) wordt weergegeven.

2. Selecteer <Display> (Weergave) en tik erop.
Het menu <Display> (Weergave) wordt weergegeven.

3. Tik op een gewenst menu.
4. Stel uw voorkeuren in en tik op <OK>.

Opties voor weergave-instellingen
Display Off (Display Uit) : Het aanraakscherm wordt automatisch uitgeschakeld 
als er gedurende de onderstaande tijd geen toetsen of pictogrammen worden 
aangeraakt. U kunt kiezen uit <15sec>, <30sec>, <1min>, <3min>, <5min> en 
<Always On> (Altijd aan). U kunt het scherm weer inschakelen door op een 
willekeurige toets te drukken. 
Brightness (Helderheid) : U kunt de helderheid van het scherm instellen. Kies 
een niveau van <0-10>, met 10 als meest helder.
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Taalinstellingen
De menu’s van de MP3-speler kunnen in diverse talen worden 
weergegeven. U kunt uw voorkeurstaal eenvoudig instellen.
1. Tik op het pictogram  in het hoofdmenu.

Het menu <Settings> (Instellingen) wordt weergegeven.

2. Selecteer <Language> (Taal) en tik erop.
Het menu <Language> (Taal) wordt weergegeven.

3. Tik op een gewenst menu.
4. Stel uw voorkeuren in en tik op <OK>.
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Opties voor taalinstellingen

Menu : De menutaal instellen. Tik op het pictogram [  ,  ] om naar de vorige/
volgende pagina te gaan.
U kunt kiezen uit <English>, , <Français>, <Deutsch>, <Italiano>, 

, < >, < >, <Español>, < >, <Magyar>, 
<Nederlands>, <Polski>, <Português>, <Svenska>, < >, < eština>,
< >, <Türkçe>, <Norsk>, <Dansk>, <Suomi>, <Español 
(Sudamérica)>, <Português (Brasil)>, <Indonesia>, <Ti ng Vi t>, <Bulgarian>, 
<Român >, < >, <Slovenš ina> of <Slovenský>.
Contents (Inhoud) : De taal instellen waarin de nummergegevens en tekst 
worden weergegeven. Tik op het pictogram [  ,  ] om naar de vorige/
volgende pagina te gaan. U kunt kiezen uit <English>, <Korean>, <French>, 
<German>, <Italian>, <Japanese>, <Simplifi ed Chinese>, <Tranditional 
Chinese>, <Spanish>, <Russian>, <Hungarian>, <Dutch>, <Polish>, 
<Portuguese>, <Swedish>, <Thai>, <Finnish>, <Danish>, <Norwegian>, 
<Farsi>, <Afrikaans>, <Basque>, <Catalan>, <Czech>, <Estonian>, <Greek>, 
<Hrvatski>, <Icelandic>, <Rumanian>, <Slovak>, <Slovene>, <Turkish> of 
<Vietnamese>.

De ondersteunde talen kunnen worden gewijzigd of toegevoegd.
OPMERKING
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Tijdinstellingen
Door de tijd in te stellen kunt u de ingestelde datum/tijd, het datumtype 
en zelfs de tijdzone gebruiken.
1. Tik op het pictogram  in het hoofdmenu.

Het menu <Settings> (Instellingen) wordt weergegeven.

2. Selecteer <Time> (Tijd) en tik erop.
Het menu <Time> (Tijd) wordt weergegeven.

3. Tik op een gewenst menu.
4. Stel uw voorkeuren in en tik op <OK>.

Opties voor Tijdinstellingen
Date/Time Set (Datum/tijd instellen) : De huidige datum 
en tijd instellen. Stel de opties <Year> (Jaar), <Month> 
(Maand), <Day> (Dag), <Hour> (Uur), <Min> en <AM/
PM> (AM/PM) in door omhoog of omlaag te gaan.
Date Type (Datumtype) : U kunt het type tijdweergave 
voor de wereldklok instellen. U kunt kiezen uit <YY-MM-
DD> (JJ-MM-DD), <MM-DD-YY> (MM-DD-JJ) en <DD-
MM-YY> (DD-MM-JJ).
Time Zone (Tijdzone) : U kunt de huidige tijd wijzigen 
door een internationale tijdzone te selecteren. U moet 
de tijdzone instellen voordat de wereldtijd kan worden 
weergegeven. Zie pagina 107.

Date&Time 
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Systeeminstellingen
In dit menu kunt u de systeeminstellingen voor de stand-bymodus, de 
startmodus, het automatisch in- en uitschakelen, het wachtwoord, de 
vergrendelopties, de standaardinstellingen, het formatteren en de info 
opgeven.
1. Tik op het pictogram  in het hoofdmenu.

Het menu <Settings> (Instellingen) wordt weergegeven.

2. Selecteer <System> (Systeem) en tik erop.
Het menu <System> (Systeem) wordt weergegeven.

3. Tik op een gewenst menu.
4. Stel uw voorkeuren in en tik op <OK>.

Opties voor systeeminstellingen
Sleep (Standby) : Het apparaat wordt na de opgegeven tijd automatisch 
uitgeschakeld. U kunt kiezen uit <Off> (Uit), <15 min >, <30 min>, <60 min>, 
<90 min> en <120 min>.
Start Mode (Startmodus) : U kunt instellen dat het startscherm wordt 
weergegeven als u de speler inschakelt. U kunt kiezen uit <Home> (Start) en 
<Last State> (Vorige status). Kies <Home> (Start) om het systeem op te starten 
in het hoofdmenu of <Last State> (Vorige status) om op te starten in het laatst 
gebruikte menuscherm.
Auto Power Off (Autom. Uitschakelen) : De speler wordt automatisch 
uitgeschakeld als het afspelen is onderbroken en er gedurende de opgegeven 
tijd geen toetsen worden ingedrukt. U kunt kiezen uit <15sec>, <30sec>, 
<1min>, <3min>, <5min> of <Always On> (Altijd aan).
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Opties voor systeeminstellingen (vervolg)

Lock (Vergrendelen) : hiermee vergrendelt u de speler met een wachtwoord om 
ongeoorloofde toegang te voorkomen. 
Als u de speler wilt vergrendelen, selecteert u <On> (Aan) en geeft u een 
wachtwoord op. Zie pagina 36.
Als u de vergrendeling wilt uitschakelen, selecteert u <Off> (Uit).
Change Password (Wachtwoord wijzigen) : hiermee kunt u het wachtwoord 
voor de vergrendelfunctie wijzigen.
Hold Option (Optie Vergrendelen) : u kunt de vergrendeloptie selecteren om 
alle knoppen te vergrendelen, zowel inclusief het aanraakscherm als alleen 
het aanraakscherm. Selecteer <All> (Alle) of <Touch Screen Only> (Alleen 
aanraakscherm). Zie pagina 24.
Default Set (Standaard instellen) : De standaardwaarden voor alle instellingen 
worden hersteld. U kunt kiezen uit <Yes> (Ja) en <No> (Nee). Met <Yes> (Ja) 
zet u alle instellingen terug naar de beginwaarden. Met <No> (Nee) annuleert u 
het herstellen van de standaardinstellingen.
Format (Formatteren) : Het interne geheugen formatteren. U kunt kiezen uit 
<Yes> (Ja) en <No> (Nee). Als u <Yes> (Ja) kiest, wordt het interne geheugen 
geformatteerd en worden alle bestanden op de speler gewist. Als u <No> (Nee) 
selecteert, wordt het interne geheugen niet geformatteerd. Controleer voordat u 
gaat formatteren.
About (Info) : De fi rmwareversie en geheugencapaciteit controleren. 

Firmware - Hier wordt de huidige versie van de fi rmware weergegeven.
Memory (Geheugen) - Geeft de resterende geheugencapaciteit aan. 

<Used> (Gebruikt) geeft het gebruikte geheugen 
aan, <Remaining> (Resterend) geeft het 
resterende geheugen aan en <Total> (Totaal) staat 
voor de totale geheugencapaciteit.

Het ingebouwde geheugen
1GB=1.000.000.000 bytes: de werkelijke, geformatteerde capaciteit is 
mogelijk minder omdat een gedeelte van het geheugen wordt gebruikt door 
de interne fi rmware.

OPMERKING
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (vervolg)
De vergrendelfunctie instellen

Wanneer u de speler vergrendelt, geeft u een wachtwoord op om 
ongeoorloofde toegang te voorkomen.
1. Selecteer <System> (Systeem) in het 

instellingenmenu en tik erop.
Het menu <System> (Systeem) wordt weergegeven.

2. Selecteer <Lock> (Vergrendelen) en tik erop.
Het Vergrendelingsvenster wordt weergegeven.

3. Selecteer <On> (Aan) en tik op <OK>.
Het invoervenster voor het nieuwe wachtwoord wordt 
weergegeven.

4. Geef het wachtwoord van vier cijfers op en tik op 
<OK>.

Het bevestigingsvenster voor het nieuwe wachtwoord 
wordt weergegeven.

5. Geef hetzelfde wachtwoord als bij stap 4 
nogmaals op en tik op <OK>.

De vergrendeling is ingesteld.
Als het apparaat wordt ingeschakeld, wordt de 
vergrendelfunctie geactiveerd.

Als <Default Set> (Standaard instellen) is geselecteerd in 
<Settings> (Instellingen)  <System> (Systeem), is de 
vergrendeling ingesteld op <Off> (Uit).

Enter New Password
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LET OP

INSTELLINGEN EN VOORKEUREN WIJZIGEN (vervolg)
De vergrendelfunctie uitschakelen
Nadat de vergrendelfunctie is ingesteld, wordt er 
een venster weergegeven waarin u een wachtwoord 
moet opgeven als u de speler inschakelt. Geef het 
wachtwoord van vier cijfers op en tik op <OK>.

De functie <Lock> (Vergrendelen) is nu uitgeschakeld.
De functie <Lock> (Vergrendelen) biedt alleen 
beveiliging tegen ongeoorloofd toegang. De 
gegevens op uw speler worden niet beveiligd. Als een 
vergrendelde speler bijvoorbeeld via een USB-kabel 
wordt aangesloten op een computer, zijn alle gegevens 
die op de speler zijn opgeslagen toegankelijk.
Als u het wachtwoord bent vergeten waarmee u de 
speler hebt vergrendeld, kunt u de speler aansluiten 
op een computer en EmoDio uitvoeren om het wachtwoord <myEmoDio> 
(EmoDio) te resetten. Zie de Help van <EmoDio> voor meer informatie.

Wachtwoord wijzigen
1. Selecteer <System> (Systeem) in het 

instellingenmenu en tik erop.
Het menu <System> (Systeem) wordt weergegeven.

2. Selecteer <Change Password> (Wachtwoord 
wijzigen) en tik erop.

Het venster voor het invoeren van het wachtwoord wordt 
weergegeven.

3. Geef het wachtwoord op en tik op <OK>.
Het venster voor het wijzigen van het wachtwoord wordt 
weergegeven.

4. Geef het wachtwoord van vier cijfers op en tik op 
<OK>.

Het bevestigingsvenster voor het nieuwe wachtwoord 
wordt weergegeven.

5. Geef hetzelfde wachtwoord als bij stap 4 nogmaals op en tik op <OK>.
Het wachtwoord wordt gewijzigd.
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DE MP3-SPELER RESETTEN
Als uw MP3-speler niet start, geen muziek wil afspelen of niet wordt herkend 
door uw computer wanneer u deze aansluit, is het misschien nodig het systeem 
te resetten.

Druk met een puntig voorwerp, zoals een 
veiligheidsspeld, aan de onderzijde van het 
product de Resetopening in.

Het systeem wordt geïnitialiseerd.
Met de Reset-functie worden geen 
tijdgegevens en gegevens in het ingebouwde 
geheugen verwijderd.
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EmoDio
EmoDio is een gebruiksvriendelijke softwaretoepassing voor het 
ordenen van bestanden op uw computer. Nadat uw bestanden 
zijn geordend in EmoDio, kunt u de bestanden in een handomdraai 
overzetten naar uw MP3-speler, zonder dat u de hele vaste schijf hoeft 
te doorzoeken voor het juiste bestand.

SYSTEEMVEREISTEN
Uw computersysteem moet minimaal voldoen aan de volgende specifi caties om 
EmoDio te installeren en gebruiken:
• Pentium 500MHz of hoger
• USB 2.0-poort
• Windows XP Service Pack 2 of hoger
• DirectX 9.0 of hoger
• 100 MB vrije schijfruimte
• Cd-romstation (2x of hoger)
• Windows Media Player 10.0 of hoger
• Resolutie 1024 X 768 of hoger
• Internet Explorer 6.0 of hoger
• 512 MB RAM of hoger
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EMODIO INSTALLEREN
Voer het installatieprogramma van <EmoDio> uit via de beheerdersaccount op uw 
computer. Anders wordt <EmoDio> niet geïnstalleerd. Meer informatie over het 
gebruik van de beheerdersaccount vindt u in de handleiding van uw computer.

1. Plaats de installatie-cd die bij de speler is 
geleverd in het cd-romstation.

2. Klik op <Install now> (Nu installeren).
Volg de instructies om de installatie te starten
De installatie van <EmoDio> wordt gestart. Wanneer de installatie is voltooid, 
verschijnt het pictogram  op uw bureaublad.

LET OP
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BESTANDEN OVERBRENGEN NAAR DE SPELER MET 
EMODIO
Met <EmoDio> kunt u bestanden en mappen selecteren en ordenen voordat u 
deze overbrengt naar de speler. Het opzoeken van bestanden op uw MP3-
speler wordt hierdoor versneld en vereenvoudigd. <EmoDio> biedt de handigste 
manier om uw bestanden van uw computer over te zetten naar uw MP3-speler.

1. Sluit het grootste uiteinde van de USB-kabel aan op de USB-aansluiting aan 
de onderkant van de speler.

2. Sluit de USB-kabel aan op de USB-poort ( ) van de computer.
Op het aanraakscherm van de speler wordt <USB connected> (USB aangesloten) 
weergegeven.
<EmoDio> wordt automatisch gestart op het moment dat de speler wordt aangesloten 
op de computer.
Als het programma niet automatisch wordt gestart, dubbelklikt u op het pictogram 
van <EmoDio> op het bureaublad.

De technologie voor het herkennen van muziek en verwante gegevens wordt 
geleverd door Gracenote en Gracenote CDDB® Music Recognition ServiceSM.
CDDB is een gedeponeerd handelsmerk van Gracenote. Het logotype en logo 
van Gracenote, Gracenote CDDB en het logo “Powered by Gracenote CDDB” zijn 
gedeponeerde handelsmerken van Gracenote. Music Recognition Service en MRS 
zijn servicemerken van Gracenote.

1

2

OPMERKING
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BESTANDEN OVERBRENGEN NAAR DE SPELER MET 
EMODIO (Vervolg)
3. Klik op het pictogram voor het type bestand 

dat u wilt overbrengen.
Klik op  om de muzieklijst weer te geven.
Klik op  om de videolijst weer te geven.
Klik op  om de afbeeldingenlijst weer te geven.

4. Klik op <Add File> (Bestand toevoegen) onder 
aan in <EmoDio>.

Het venster <Open> (Openen) wordt weergegeven.

5. Selecteer de bestanden die u wilt toevoegen 
en klik op <Open> (Openen).

De bestanden worden aan de lijst aan de linkerzijde 
van het scherm <EmoDio> toegevoegd.

6. Selecteer het bestand dat u wilt overzetten in de 
lijst aan de linkerkant.

7. Klik op het pictogram  .
Het geselecteerde bestand wordt overgebracht naar 
de speler.

4

3

5

76
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BESTANDEN OVERBRENGEN NAAR DE SPELER MET 
EMODIO (Vervolg)

Koppel de USB-kabel niet los tijdens de bestandsoverdracht. Loskoppelen van 
de USB-connector tijdens bestandsoverdracht kan leiden tot beschadiging van de 
speler en de computer.
Sluit de speler rechtstreeks op de computer aan in plaats van via een USB-hub. 
Zo voorkomt u een instabiele verbinding.

Wanneer u een videobestand naar de speler overbrengt met <EmoDio>, wordt het 
bestand vóór de overdracht geconverteerd naar de indeling SVI. Tevens wordt de 
bestandsgrootte aangepast. 
Wanneer u een afbeelding naar de speler overbrengt met <EmoDio>, wordt het 
bestand vóór de overdracht geconverteerd naar JPG-indeling. Tevens wordt de 
bestandsgrootte aangepast.
Een afbeelding die u naar de speler overbrengt zonder <EmoDio>, kan er op het 
scherm anders uitzien dan de originele afbeelding.
Zolang de speler is aangesloten op de computer, zijn alle functies uitgeschakeld.
Als u de USB-kabel op de computer aansluit terwijl de batterij bijna leeg is, wordt de 
speler eerst enkele minuten opgeladen voordat de verbinding met de computer tot 
stand wordt gebracht.
EmoDio heef een uitgebreide Help-functie. Als u het antwoord op uw vraag over 
EmoDio hier niet kunt vinden, klikt u op <MENU> <Help> <Help> aan de 
bovenkant van het venster van <EmoDio>.
Wat is SVI?
Samsung Audio Video Interleaving (SVI) is een nieuwe video-indeling, ontwikkeld 
door en in beheerd van Samsung.

LET OP
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een video bekijken
Voordat u begint! -  Breng videobestanden over naar de speler via <EmoDio> 

(EmoDio). Zie pagina 41.
De oortelefoon aansluiten, de speler aanzetten en de batterij 
controleren.

Druk op het pictogram [ ] om naar het vorige scherm te gaan.
Houd het pictogram [ ] enige tijd ingedrukt om het hoofdmenu weer te geven.

1. Tik op het pictogram  in het hoofdmenu.
De lijst met video’s wordt weergegeven.

2. Selecteer een af te spelen videobestand en tik erop.
Het geselecteerde videobestand wordt horizontaal afgespeeld.

PAUZEREN
1. Tik tijdens het afspelen op het pictogram [ ].

Het afspelen van de video wordt gepauzeerd.

2. Tik op het pictogram [ ] om het afspelen te hervatten.
De video wordt afgespeeld vanaf het punt waar het afspelen is gestopt. 

Informatie en pictogrammen verdwijnen na enige tijd bij het afspelen van video’s. 
Tik op het scherm als u deze informatie en pictogrammen weer wilt weergeven.
Wanneer u een videobestand naar de speler overbrengt met <EmoDio> (EmoDio), 
wordt het bestand vóór de overdracht geconverteerd naar de indeling SVI. Tevens 
wordt de bestandsgrootte aangepast.

OPMERKING
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NAAR EEN SPECIFIEK FRAME GAAN
Instructie 1
1. Houd het pictogram [ , ] in de 

horizontale weergave tijdens het 
afspelen kort ingedrukt.

Hierdoor kunt u in het huidige 
videobestand vooruit en achteruit 
spoelen.

2. Haal uw vinger van het pictogram als 
u naar de gewenste positie hebt gespoeld.

De video begint op dit punt af te spelen.

Instructie 2
Tik op het punt op de afspeelstatusbalk waar u het afspelen wilt starten.

De video wordt afgespeeld vanaf het door u geselecteerde punt.

Door uw vinger op het scherm naar links of rechts te bewegen spoelt u 
vooruit of achteruit, afhankelijk van de instelling voor horizontale slag. Zie 
pagina 52.

OPMERKING
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HET VORIGE VIDEOBESTAND AFSPELEN
Instructie 1
Tik binnen 3 seconden nadat de huidige 
video is begonnen met afspelen op het 
pictogram [ ].
Tik binnen 3 seconden nadat de huidige 
video is begonnen met afspelen twee keer 
op het pictogram [ ].

Instructie 2
Beweeg uw vinger naar rechts.

De vorige video wordt nu afgespeeld.

HET VOLGENDE VIDEOBESTAND AFSPELEN
Instructie 1
Klik op het pictogram [ ].

Instructie 2
Beweeg uw vinger naar links.

De volgende video wordt nu afgespeeld.

Instructie 2

Instructie 2

Video Track 0

Video Track 2



een video bekijken _ 47

HET VIDEOMENU GEBRUIKEN
Een bladwijzer instellen
Als u een bladwijzer instelt voor een bepaalde scène, kunt u die 
opnieuw bekijken wanneer u maar wilt.
1. Tik tijdens de gewenste scène op het 

pictogram [ ].
Het menu <Video> wordt weergegeven.

2. Tik op <Bookmark> (Bladwijzer).
Het menu <Bookmark> (Bladwijzer) wordt 
weergegeven.

3. Tik op <Add> (Toev).
Op het huidige punt wordt een bladwijzer ingesteld.
U ziet het symbool [ | ] op de afspeelstatusbalk.

Het venster Overschrijven verschijnt als er al eerder een bladwijzer 
is ingesteld. Als u <Yes> (Ja) selecteert, wordt de eerder ingestelde 
bladwijzer verwijderd en wordt er een nieuwe bladwijzer toegevoegd.
U kunt één bladwijzer per video instellen met een maximum van 100 
bladwijzers.
Het punt van de bladwijzer kan iets afwijken van het eigenlijke punt.
Tik op het pictogram [ ] om het menu te verlaten.

OPMERKING
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HET VIDEOMENU GEBRUIKEN (Vervolg)
Naar de bladwijzer gaan (afspelen)/de bladwijzer verwijderen
1. Tik op het pictogram [ ] in het 

video-afspeelscherm.
Het menu <Video> wordt weergegeven.

2. Tik op <Bookmark> (Bladwijzer).
Het menu <Bookmark> (Bladwijzer) wordt 
weergegeven.

3. Tik op <Go to> (Ga naar) of <Delete>
(Wissen).

Als u <Go to> (Ga naar) selecteert, gaat u naar de geselecteerde bladwijzer 
en wordt deze afgespeeld.
Met <Delete> (Wissen) verwijdert u de geselecteerde bladwijzer uit het 
videobestand.

De Digital Natural Sound-engine (DNSe) instellen
De juiste geluidsweergave voor elk videogenre selecteren.
1. Tik tijdens de gewenste scène op het 

pictogram [ ].
Het menu <Video> wordt weergegeven.

2. Tik op <DNSe>.
Het menu <DNSe> wordt weergegeven.

3. Tik op een gewenste DNSe.
U kunt kiezen uit <Normal> (Normaal), <Drama>en <Action> (Hand.).

Wat is SVI?
Digital Natural Sound Engine (DNSe) is een functie voor geluidseffecten 
voor MP3-spelers die is ontwikkeld door Samsung. Dit biedt verschillende 
geluidsinstellingen voor het verbeteren van het type muziek waar u naar 
luistert.

OPMERKING
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HET VIDEOMENU GEBRUIKEN (Vervolg)
De afspeelsnelheid instellen
U kunt de afspeelsnelheid van uw favoriete video versnellen of 
vertragen.
1. Tik op het pictogram [ ] in het 

video-afspeelscherm.
Het menu <Video> wordt weergegeven.

2. Tik op <Play Speed> (Afspeelsnelheid).
Het scherm voor de afspeelsnelheid 
wordt weergegeven.

3. Tik op het pictogram [  ,  ] om de gewenste afspeelsnelheid te 
selecteren en tik op <Yes> (Ja).

U kunt kiezen uit <X0.5>, <X0.6>, <X0.7>, <X0.8>, <X0.9>, 
<X1.0(Normaal)>, <X1.1>, <X1.2>, <X1.3>, <X1.4> en <X1.5>.
Hoe hoger het getal, des te sneller de afspeelsnelheid.

Afhankelijk van het bestand kan de aangepaste snelheid afwijken van de 
ingestelde snelheid.

Voor een wmv-bestand kan de afspeelsnelheid maximaal worden ingesteld 
op X1.5.

Bookmark

DNSe

Play Speed

OPMERKING
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HET VIDEOMENU GEBRUIKEN (Vervolg)
Het schermformaat selecteren
U kunt het weergaveformaat voor het afspelen van video’s selecteren.
1. Tik tijdens de gewenste scène op het 

pictogram [ ].
Het menu <Video> wordt weergegeven.

2. Tik op <Display> (Weergave).
Het menu <Display> (weergave) wordt 
weergegeven.

3. Tik op <Screen Size> (Schermformaat).
Het menu <Screen Size> (Schermformaat) wordt weergegeven.

4. Tik op het gewenste schermformaat.
U kunt kiezen uit <Actual> (Werkelijk), <Standard> (Standaard), <Full> 
(Volledig) en <Zoom>.

Het menu Schermformaat

             Standard <Standaard>      Full <Volledig>                <Zoom>

Voor sommige videobestanden wordt het menu <Screen Size> 
(Schermformaat) of andere verwante menu’s mogelijk niet weergegeven.OPMERKING
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HET VIDEOMENU GEBRUIKEN (Vervolg)
De helderheid wijzigen
U kunt de helderheid van het videoscherm instellen.
1. Tik tijdens de gewenste scène op het 

pictogram [ ].
Het menu <Video> wordt weergegeven.

2. Tik op <Display> (Weergave).
Het menu <Display> (weergave) wordt 
weergegeven.

3. Tik op <Brightness> (Helderheid).
Het scherm voor de helderheid wordt weergegeven.

4. Selecteer de gewenste helderheid en tik op <Yes> (Ja).
Selecteer een niveau tussen <0-10>.

Het menu voor de helderheid is alleen van toepassing op het videoscherm.

Het scherm uitschakelen
U kunt het aanraakscherm uitschakelen en alleen het geluid weergeven 
om energie te besparen.

Volg stap 1~2 zoals hierboven.
3. Tik op <Display Off> (Display Uit).

Het aanraakscherm wordt uitgeschakeld.
Als u het scherm weer wilt inschakelen, 
tikt u op het aanraakscherm.

Play Speed
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HET VIDEOMENU GEBRUIKEN (Vervolg)
De horizontale slag instellen
U kunt snel vooruit door een bestand bladeren met verschillende 
intervallen als u het scherm links of rechts aanraakt. Sla een heel 
bestand over of meerdere seconden tegelijkertijd.
1. Tik tijdens de gewenste scène op het 

pictogram [ ].
Het menu <Video> wordt weergegeven.

2. Tik op <Horizontal Stroke> 
(Horizontale slag).

Het menu <Horizontal Stroke> 
(Horizontale slag) wordt weergegeven.

3. Tik op de gewenste horizontale slag.
U kunt kiezen uit <1 File> (1 best.), <Seek> (Zoeken), <10sec Skip> (10sec 
Oversl.), <30sec Skip> (30sec Oversl.) en <1min Skip> (1min Overslaan.).
Links : Vooruit, afhankelijk van de intervalinstelling van de horizontale slag.
Rechts : Achteruit, afhankelijk van de intervalinstelling van de horizontale 
slag.
<1 File> (1 best.) : Als u <Horizontal Stroke> (Horizontale slag) instelt op <1 
File> (1 best.), wordt het vorige of volgende bestand geselecteerd.
Als u de optie Seek <Searching> instelt, kunt u door de afspeelsnelheden 
<x2>  <x4>  <x8> bladeren door uw vinger naar links of rechts te 
bewegen.

Het interval van de horizontale slag kan verschillen van het eigenlijke 
interval voor overslaan.

OPMERKING
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HET VIDEOMENU GEBRUIKEN (Vervolg)
Voordat u begint! - Gebruik alleen stereokoptelefoons die zijn gecertifi ceerd 
voor Bluetooth. Controleer of uw Bluetooth-stereokoptelefoon is geregistreerd. 
<Connect to Headset> (Verb. met koptelefoon) wordt weergegeven als er een 
geregistreerde koptelefoon aanwezig is. Zie <Een Bluetooth-stereokoptelefoon 
gebruiken> voor meer informatie. Zie pagina 113.

Verbinding maken met een Bluetooth-stereokoptelefoon
U kunt tijdens het afspelen van video rechtstreeks verbinding maken 
met een geregistreerde Bluetooth-koptelefoon.
1. Tik tijdens de gewenste scène op het 

pictogram [ ].
Het menu <Video> wordt weergegeven.

2. Tik op <Connect to Headset> (Verb. 
met koptelefoon).

Als <Bluetooth Mode> (Bluetooth Mode) is 
ingesteld op <Off> (Uit), wordt dit gewijzigd 
in <On> (Aan).
Wanneer de verbinding tot stand is gebracht, ziet u het pictogram [ ] op het 
scherm.
U kunt genieten van audio en video via de Bluetooth-koptelefoon.

De verbinding met de Bluetooth-stereokoptelefoon verbreken
1. Tik tijdens de gewenste scène op het 

pictogram [ ].
Het menu <Video> wordt weergegeven.

2. Tik op <Disconnect Headset> 
(Headset loskoppelen).

De verbinding met de Bluetooth-koptelefoon 
is verbroken.

U kunt <DNSe> en <Play Speed> (Afspeelsnelheid) niet instellen als de speler 
is verbonden met de Bluetooth-headset in de videomodus.OPMERKING
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Music

Now Playing

Artists

Albums

Songs

Genres

Playlists

Recorded Files

Music Browser

Songs 1/52

Rising Sun

muziek beluisteren
Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij 

controleren.
Druk op het pictogram [ ] om naar het vorige scherm te gaan.
Houd het pictogram [ ] enige tijd ingedrukt om het hoofdmenu weer te geven.

LUISTEREN OP CATEGORIE

1. Tik op het pictogram  in het hoofdmenu.
De <Music> (Muziek) lijst wordt weergegeven.

2. Selecteer een gewenst item in de muzieklijst en tik erop.
Het muziekbestand wordt weergegeven.

3. Selecteer een af te spelen muziekbestand en tik erop.
De muziek wordt afgespeeld.

OPMERKING
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LUISTEREN OP CATEGORIE (Vervolg)
Muzieklijst
Bestandsinformatie, waaronder naam van de artiest, naam van het album, titel van het 
nummer en het genre worden weergegeven, gebaseerd op de ID3-taginformatie bij 
het muziekbestand. Bestanden zonder ID3-Tag worden weergegeven als <Unknown> 
(onbekend).

Now Playing (Nu Speelt) : Speelt een recent afgespeeld bestand of gaat naar het 
afspeelscherm van het huidige bestand.
Artists (Artiest) : Afspelen op artiest                                                
Albums (Album) : Afspelen op album. De albumhoes wordt weergegeven.
Songs (Nummers) : Afspelen in numerieke of alfabetische volgorde           
Genres (Genre) : Afspelen op genre
Playlists : Afspelen op afspeellijst
Recorded Files (Opgenomen Bestanden) : Toont alle opgenomen bestanden.
Music Browser (Muziekbrowser) : Geeft alle muziekbestanden in de muziekmap weer.

De speler kan MP3-, WMA- en AAC-muziekbestanden afspelen.
MP1- of MP2-bestanden waarvan alleen de extensie is gewijzigd in MP3, kunnen 
niet worden afgespeeld op de speler.
Wat is een ID3-parameter?
Dit is een tag in een MP3-bestand die informatie bevat over het bestand, zoals de 
titel, de artiest, het album, het jaar, het genre en een veld voor opmerkingen.

OPMERKING
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PAUZEREN
1. Tik op het pictogram [ ] of druk op de knop  tijdens het afspelen 

van muziek.
Het afspelen van de muziek wordt onderbroken.

2. Tik op het pictogram [ ] of druk nogmaals op de knop .
De muziek wordt afgespeeld vanaf het punt waar het afspelen is gestopt.

AFSPELEN VANAF HET BEGIN VAN HET HUIDIGE NUMMER
1. Tik na 3 seconden afspelen op het pictogram [ ].

Het huidige nummer wordt afgespeeld vanaf het begin.

HET VORIGE NUMMER AFSPELEN
Instructie 1
Tik binnen 3 seconden afspelen op het pictogram
[ ].
Tik na 3 seconden afspelen twee keer op het 
pictogram [ ].

Instructie 2
Beweeg uw vinger naar rechts.

Het vorige nummer wordt afgespeeld.

Wanneer u VBR-bestanden afspeelt, wordt het vorige nummer mogelijk niet 
afgespeeld, ook al tikt u binnen 3 seconden op het pictogram [ ].

Instructie 2

Rising Sun

Songs 52/52

LET OP
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HET VOLGENDE NUMMER AFSPELEN
Instructie 1
Klik op het pictogram [ ].

Instructie 2
Beweeg uw vinger naar links.

Het volgende nummer wordt afgespeeld.

ZOEKEN BINNEN EEN NUMMER
Instructie 1
1. Houd het pictogram [ ] of [ ] enige tijd 

ingedrukt terwijl het geselecteerde nummer wordt 
afgespeeld.

Er wordt gezocht richting het begin of het einde van het 
nummer.

2. Laat het pictogram los op het punt waar u wilt 
starten.

Het nummer wordt afgespeeld vanaf het moment dat u 
het pictogram loslaat.

Instructie 2
Tik op een gewenst punt in de afspeelstatusbalk.

Door uw vinger op het scherm naar links of rechts te bewegen spoelt u 
vooruit of achteruit, afhankelijk van de instelling voor horizontale slag. 
Zie pagina 74.

Instructie 2

Rising Sun

Songs 1/52

Rising Sun

Songs 2/52
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EEN FRAGMENT HERHAALD AFSPELEN
Deze functie stelt u in staat om een bepaald gedeelte van een nummer 
meerdere keren achter elkaar te beluisteren. Dit is bijvoorbeeld handig wanneer 
u een taal probeert te leren.
1. Tik op het pictogram [ ] aan het begin van het 

fragment dat u wilt herhalen.
Het startpunt is ingesteld en <A > wordt weergegeven.

2. Tik nogmaals op het pictogram [ ] om het eind van 
het fragment op te geven dat u wilt herhalen.

<AB> wordt weergegeven en het betreffende fragment wordt 
herhaald afgespeeld.

Herhaald afspelen annuleren
Tik tijdens het herhaald afspelen van het fragment op het pictogram
[ ].

Het herhalen van het fragment wordt geannuleerd.

U kunt het begin- en eindpunt voor de herhaling slechts voor één bestand 
tegelijkertijd opgeven.

Rising Sun

Songs 1/52

OPMERKING
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DE ALBUMHOES EN DE ALBUMGEGEVENS 
TEGELIJKERTIJD WEERGEVEN
U kunt zowel de afbeelding van de hoes van het album als de 
albumgegevens weergegeven in het ingezoomde scherm.
Tik in het afspeelscherm voor de muziek twee keer op het 
aanraakscherm.

U kunt de afbeelding van de hoes en de albumgegevens 
tegelijkertijd weergeven.
Om terug te keren naar het vorige scherm, tikt u twee keer op het 
aanraakscherm.

Songs 1/52

Rising Sun
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EEN AFSPEELLIJST MAKEN MET EMODIO
Met <EmoDio> kunt u uw eigen collectie of afspeellijst met geluidsbestanden 
samenstellen.

Voordat u begint! - Sluit de speler aan op de computer.
EmoDio moet zijn geïnstalleerd op de computer.

Een afspeellijst maken

1. Klik op <Playlists> (Afspeellijsten) boven in <EmoDio>.
Het venster <Playlists> wordt weergegeven.

2. Klik onder in het venster op <New Playlists> (Nieuwe 
Afspeellijsten).

Het venster <Create Playlists> (Maken afspeellijsten) wordt weergegeven.

3. Geef een titel voor de afspeellijst op en klik op [OK].
De nieuwe afspeellijst krijgt een naam en wordt opgeslagen in het gedeelte 
<Playlists> (Afspeellijsten) in <EmoDio>.

2

1

OK 3
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EEN AFSPEELLIJST MAKEN MET EMODIO (Vervolg)
Muziekbestanden toevoegen aan een afspeellijst die 
u hebt gemaakt

1. Klik op <My PC> (Mijn PC) boven in <EmoDio>.
Het venster <My PC> (Mijn PC) wordt weergegeven.

2. Klik op <Playlists> (Afspeellijsten) in de rechterhoek van het 
venster.

Het venster <Playlists> wordt weergegeven.

3. Dubbelklik op een album in het rechtervenster.
4. Selecteer in het venster <My PC> (Mijn PC) de bestanden die u wilt 

overbrengen.
5. Klik op het symbool .

De geselecteerde bestanden worden aan de afspeellijst toegevoegd.

5
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EEN AFSPEELLIJST MAKEN MET EMODIO (Vervolg)
Een afspeellijst naar de speler overbrengen met EmoDio

1. Klik op <Playlists> (Afspeellijsten) boven in <EmoDio>.
Het venster <Playlists> (Afspeellijsten) wordt weergegeven.

2. Selecteer een afspeellijst in het gedeelte <Playlists> (Afspeellijsten).
3. Klik op het symbool .

De geselecteerde afspeellijst wordt map voor map overgezet naar 
<File Browser> (Bestandsbrowser)  <Playlists> (Afspeellijsten).

De speler kan maximaal 400 afspeellijsten afspelen met maximaal 400 
muziekbestanden per afspeellijst.

Zie de Help van <EmoDio> voor meer informatie over Playlist DNSe.

OPMERKING
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EEN AFSPEELLIJST OP UW MP3-SPELER MAKEN
Als u al bestanden hebt gedownload naar uw MP3-speler, kunt u een afspeellijst 
met ‘Favorieten’ samenstellen zonder de hulp van EmoDio of uw computer.
1. Tik op het pictogram  in het hoofdmenu.
2. Selecteer <Music> (Muziek) en tik erop.

De lijst met muziekbestanden wordt weergegeven.

3 Selecteer een bestand om toe te voegen aan de afspeellijst 
en tik op het pictogram [ ].

Het menu Afspeellijst wordt weergegeven.

4. Tik op <Add to Playlist> (Toev. aan afsp.).
<Playlist 1> (Afspeellijst 1) tot en met <Playlist 5> (Afspeellijst 5) 
wordt weergegeven.

5. Tik op het afspeellijstnummer waar u het geselecteerde 
bestand aan wilt toevoegen.

Het geselecteerde bestand wordt toegevoegd aan de afspeellijst.
U kunt de afspeellijst bekijken via <Music> (Muziek) 
<Playlists> (Afspeellijsten)  <Playlist 1> (Afspeellijst 1) tot en 
met <Playlist 5> (Afspeellijst 5) in het hoofdmenu.

U kunt maximaal 200 muziekbestanden toevoegen aan elke 
afspeellijst (<Playlist 1> (Afspeellijst 1) tot en met <Playlist 5> 
(Afspeellijst 5)).

OPMERKING
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EEN AFSPEELLIJST AFSPELEN
1. Tik op het pictogram  in het hoofdmenu.

De muzieklijst wordt weergegeven.

2. Selecteer <Playlists> (Afspeellijsten) en tik erop.
De afspeellijsten worden weergegeven.

3. Selecteer de gewenste afspeellijst en tik erop.
De muziekbestanden van de geselecteerde afspeellijst worden 
weergegeven.
Als geen afspeellijst wordt gevonden, wordt de melding <No File> 
(Geen bestanden.) op het scherm weergegeven.

4. Selecteer een af te spelen muziekbestand en tik erop.
Het muziekbestand wordt afgespeeld.

Zie pagina’s 60 en 62 voor meer informatie over hoe u een 
afspeellijst overbrengt met <EmoDio>.
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EEN BESTAND VERWIJDEREN UIT DE AFSPEELLIJST
1. Tik op het pictogram  in het hoofdmenu.

De muzieklijst wordt weergegeven.

2. Selecteer <Playlists> (Afspeellijsten) en tik erop.
De afspeellijsten worden weergegeven.

3. Selecteer de gewenste afspeellijst en tik erop.
De muziekbestanden van de geselecteerde afspeellijst worden 
weergegeven.

4. Selecteer een bestand om te verwijderen uit de afspeellijst 
en tik op het pictogram [ ].

Het menu Afspeellijst wordt weergegeven.

5. Tik op <Delete from Playlist> (Verw. uit afspeellijst).
Het bevestigingsvenster voor verwijderen wordt weergegeven.

6. Tik op <Yes> (Ja).
Het geselecteerde bestand wordt verwijderd uit de afspeellijst.

Het geselecteerde bestand kan niet worden verwijderd als deze wordt afgespeeld.

ALLE BESTANDEN VERWIJDEREN UIT DE AFSPEELLIJST
Volg stap 1 tot en met 3 hierboven.
4. Tik op het pictogram [ ].

Het menu Afspeellijst wordt weergegeven.

5. Tik op <Delete All from Playlist> (Alles verw. uit afsp.lijst).
Het bevestigingsvenster voor verwijderen wordt weergegeven.

6. Tik op <Yes> (Ja).
Alle bestanden worden uit de afspeellijst verwijderd.

Playlist 1 1/5
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HET MUZIEKMENU GEBRUIKEN
Via het menu Muziek heeft u controle over alle facetten van het luisteren 
naar muziek; van het herhalen van nummers en albums tot het kiezen van de 
schermachtergrond tijdens het afspelen van muziek.

Het geluidseffect instellen
U kunt genieten van helderder geluid.
1. Tik op het pictogram [ ] in het 

muziekafspeelscherm.
Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op <Sound Effect> (Geluidseffect).
Het menu <Sound Effect> (Geluidseffect) wordt 
weergegeven.

3. Tik op het gewenste geluidseffect.
U kunt kiezen uit <Street Mode> (Straatmodus) en 
<Playlist DNSe> (DNSe-afspeellijst).

Opties voor geluidseffecten
Street Mode (Straatmodus) : In deze modus kunt u ook buiten luisteren naar 
muziek met een helder geluid, doordat straatgeluiden gefi lterd worden. U kunt 
kiezen uit <Off> (Uit) en <On> (Aan).
Playlist DNSe (DNSe-afspeellijst) : als een afspeellijst die via <EmoDio> is 
overgebracht naar de speler een gebruikers-DNSe bevat, is het geluidseffect 
ingesteld op Playlist DNSe. Als u <Off> (Uit) selecteert, wordt het vorige 
geluidseffect ingesteld.

Als u voor <Playlist DNSe> (DNSe-afspeellijst) de optie <On> (Aan) 
inschakelt wanneer een afspeellijst die via <EmoDio> wordt overgebracht, 
een gebruikers-DNSe bevat, wordt <Playlist DNSe> (DNSe-afspeellijst) 
weergegeven in het menu <DNSe> en kunt u een ander geluidseffect 
opgeven.
Zie de Help van <EmoDio> voor meer informatie over Playlist DNSe.

Tik op het pictogram [ ] om het menu te verlaten.

Songs 1/52

Sound Effect

DNSe

Play Mode

TTS

Music Play Screen

Play Speed

Add to Alarm

Horizontal Stroke

Street Mode

Playlist DNSe

OPMERKING



muziek beluisteren _ 67

HET MUZIEKMENU GEBRUIKEN (Vervolg)
De Digital Natural Sound-engine (DNSe) instellen (DNSe)
Hier selecteert u de juiste geluidsweergave voor elk muziekgenre.
1. Tik op het pictogram [ ] in het 

muziekafspeelscherm.
Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op <DNSe>.
Het menu <DNSe> wordt weergegeven.

3. Tik op een van de DNSe-opties.
U kunt kiezen uit <Normal> (Normaal), <Studio>, 
<Rock>, <Classical> (Klassiek), <Jazz>, <Ballad>, 
<Club>, <Rhythm & Blues>, <Dance>, <Concert Hall> 
(Concertzaal) en d <myDNSe>.
Als u <myDNSe> selecteert, kunt u een gebruikers-
DNSe opgeven. Zie pagina 68.

Wat is DNSe?
Digital Natural Sound Engine (DNSe) is een functie voor geluidseffecten 
voor MP3-spelers die is ontwikkeld door Samsung. Dit biedt verschillende 
geluidsinstellingen voor het verbeteren van het type muziek waar u naar 
luistert.

OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
myDNSe selecteren
U kunt een gebruikers-DNSe instellen op uw speler of de gebruikers-
DNSe overbrengen via <EmoDio>.
1. Tik op het pictogram [ ] in het 

muziekafspeelscherm.
Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op <DNSe>.
Het menu <DNSe> (DNSe) wordt weergegeven.

3. Tik op <myDNSe>.
Het menu <myDNSe> wordt weergegeven.

4. Selecteer de gewenste gebruikers-DNSe en tik 
erop.

De geselecteerde gebruikers-DNSe wordt ingesteld.
U kunt <c> (EQ) en 3D&Bass < 3D&Bass> (3D en bas) instellen als u 
<myDNSe> (myDNSe) hebt geselecteerd. Zie pagina 69~70.

Zie de Help van <EmoDio> voor meer informatie over het instellen van een 
gebruikers-DNSe via <EmoDio>.
U kunt maximaal 97 gebruikers-DNSe-instellingen overbrengen naar de 
speler, met uitzondering van <User 1> (Gebruiker 1) tot en met <User 3> 
(Gebruiker 3).
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
myDNSe selecteren (Vervolg)
<EQ>
U kunt individuele frequenties aanpassen om het geluid volgens uw 
voorkeur in te stellen.
Als u de frequenties een voor een instelt :
1. Selecteer de gewenste gebruikers-DNSe in het menu 

myDNSe en tik op het pictogram [ ].
Het scherm <User> (Gebruiker) wordt weergegeven.

2. Tik op <EQ>
Het instellingenscherm <EQ> wordt weergegeven.

3. Tik op het pictogram [  , ] om de frequentie 
te selecteren die u wilt aanpassen, en tik op 
het pictogram [  , ] om het niveau van de 
geselecteerde frequentie aan te passen.

U kunt kiezen uit <–10 - +10> voor het niveau van de 
geselecteerde frequentie.

4. Tik op <OK>.
De instelling is voltooid.

Als u alle frequenties in een keer wilt instellen:
Volg stap 1-2 hierboven.
3. Tik op het pictogram [ ].

Telkens wanneer u op [ ] tikt, schakelt u tussen 
<Select One> (Eén selecteren)/<Select All> (Alles 
selecteren).

4. Tik op het pictogram [ , ] om het niveau van de 
geselecteerde frequentie aan te passen.

Alle frequenties worden gewijzigd.
5. Tik op <OK>.

De instelling is voltooid.
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
myDNSe selecteren (Vervolg)
<3D&Bass> (3D en bas)
Met deze optie stelt u 3D-geluidseffecten en extra bas in.
1. Selecteer de gewenste gebruikers-DNSe in het 

menu myDNSe en tik op het pictogram [ ].
Het scherm <User> (Gebruiker) wordt weergegeven.

2. Tik op <3D&Bass> (3D en bas).
Het instellingenscherm <3D&Bass> (3D en bas) wordt 
weergegeven.

3. Selecteer <3D> (3D) of <Bass> (Bas) en tik op 
het pictogram [ , ] om het gewenste punt in te 
stellen.

Voor <3D> (3D) en <Bass> (Bas) kunt u kiezen uit <0-4>.
4. Tik op <OK>.

De instelling is voltooid.

<Clarity> (Helderheid)
Geniet van een helderder geluid met verbeterde kwaliteit.
1. Selecteer de gewenste gebruikers-DNSe in het 

menu myDNSe en tik op het pictogram [ ].
Het scherm <User> (Gebruiker) wordt weergegeven.

2. Tik op <Clarity> (Helderheid).
Het instellingscherm <Clarity> (Helderheid) wordt 
weergegeven.

3. Tik op het gewenste niveau.
U kunt kiezen uit <0-2>.

4. Tik op <OK>.
De instelling is voltooid.
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
De afspeelmodus instellen
De afspeelmodus selecteren, zoals de herhaalinstellingen.
1. Tik op het pictogram [ ] in het muziekafspeelscherm.

Het menu <Music> (Muziek) wordt weergegeven.
2. Tik op <Play Mode> (Afspeelmodus).

Het menu <Play Mode> (Afspeelmodus) wordt weergegeven.
3. Tik op de gewenste afspeelmodus.

U hebt de keuze uit <Normal> (Normaal), <Repeat> 
(Herhaal), <Repeat One> (Eén herhalen) of <Shuffl e>.

Opties voor afspeelmodus
Normal (Normaal) : Alle nummers worden één keer in de 
normale volgorde afgespeeld.
Repeat (Herhaal) : Om alle bestanden in de huidige map te 
herhalen.
Repeat One (Eén herhalen) : Eén bestand wordt herhaald.
Shuffl e : Bestanden worden in willekeurige volgorde 
afgespeeld.

Naar TTS (Text to Speech) luisteren
Met de TTS-functie van <EmoDio>, kunt u een tekstbestand 
converteren naar een MP3-bestand en het bestand 
afspelen.
1. Tik op het pictogram [ ] in het muziekafspeelscherm.

Het menu <Music> (Muziek) wordt weergegeven.
2. Tik op <TTS>.

Het menu <TTS> wordt weergegeven.
3. Tik op <On> (Aan).

U kunt het bestand afspelen.

Zie de Help van <EmoDio> voor meer informatie over de 
TTS-functie van <EmoDio>.
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
Het muziekafspeelscherm selecteren
Kies een achtergrondafbeelding uit de geboden mogelijkheden of kies 
uw eigen achtergrondafbeelding. Deze wordt weergegeven terwijl u naar 
muziek luistert.
1. Tik op het pictogram [ ] in het 

muziekafspeelscherm.
Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op <Music Play Screen> (Muziekafspeelscherm).
Het menu <Music Play Screen> (Muziekafspeelscherm) 
wordt weergegeven.

3. Tik op het pictogram [  , ] om een 
muziekafspeelscherm te selecteren en tik op <OK>.

U kunt kiezen uit <Type 1>, <Type 2>, <Type 3>, <Type 
4>, <Album Info.> en <Album Art> (Albumontw.).

Opties voor muziekafspeelscherm
Type 1 ~ Type 4 (Type 1 ~ Type 4) : U kunt een muziekafspeelscherm naar keuze 
selecteren.
Album Info. (Albuminfo.) : Informatie over de naam van de artiest, het album 
en het genre wordt weergegeven als ID3-taginformatie is opgeslagen in het 
muziekbestand.
Album Art (Albumontw.) : Een afbeelding van de cd-hoes wordt weergegeven als 
deze informatie is opgenomen in de ID3-taginformatie van het muziekbestand. 
Afbeeldingen van cd-hoesjes worden ondersteund als deze niet groter zijn dan 200 
pixels (horizontaal) x 200 pixels (verticaal).

Wat is een ID3-parameter?
Dit is een tag in een MP3-bestand die informatie bevat over het bestand, 
zoals de titel, de artiest, het album, het jaar, het genre en een veld voor 
opmerkingen.

OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
De afspeelsnelheid instellen
U kunt de afspeelsnelheid van uw favoriete muziek versnellen of 
vertragen.

1. Selecteer een muziekbestand om toe te voegen 
aan de alarmgeluiden en tik op het pictogram
[ ].

Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op <Play Speed> (Afspeelsnelheid).
Het menu <Play Speed> (Aspeelsnelheid) wordt 
weergegeven.

3. Tik op het pictogram [ , ] om de gewenste 
afspeelsnelheid te selecteren.

U kunt kiezen uit <X 0.7>, <X0.8>, <X 0.9>, 
<X 1.0(Normaal)>, <X 1.1>, <X 1.2> en <X 1.3>
Hoe hoger het getal, des te sneller de afspeelsnelheid.

Afhankelijk van het bestand kan de aangepaste snelheid afwijken van de 
ingestelde snelheid.OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
Alarmgeluiden toevoegen
U kunt uw favoriete muziekbestanden toevoegen aan de lijst met 
wekkergeluiden, zodat u dit de volgende keer dat het alarm afgaat, 
hoort. Zie pagina 102 over het instellen van het alarm.
1. Selecteer een muziekbestand om toe te voegen aan 

de alarmgeluiden en tik op het pictogram [ ].
Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op <Add to Alarm> (Bijvoegen aan Alarm).
Het venster Opslaan wordt weergegeven. 

3. Tik op <OK>.
De geselecteerde muziek wordt toegevoegd aan de 
lijst met alarmgeluiden.
Er kan één muziekbestand worden toegevoegd als 
alarmgeluid.

De horizontale slag instellen
U kunt het slaginterval voor het bladeren door muziekbestanden instellen 
door uw vinger op het scherm naar links of naar rechts te bewegen.
1. Tik op het pictogram [ ] in het

muziekafspeelscherm.
Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op <Horizontal Stroke> (Horizontale slag).
Het menu <Horizontal Stroke> (Horizontale slag) 
wordt weergegeven.

3. Tik op de gewenste horizontale slag.
U kunt kiezen uit <1 File> (1 best.), <10sec Skip> (10 
sec Oversl), <30sec Skip> (30 sec Oversl) en <1min 
Skip> (1 min Overslaan).

Als het bestand is opgenomen met een variabele 
bitrate, komt de horizontale slag mogelijk niet precies 
overeen met wat u hebt ingesteld.

OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
Voordat u begint! - Gebruik alleen stereokoptelefoons die zijn gecertifi ceerd 
voor Bluetooth. Controleer of uw Bluetooth-stereokoptelefoon is geregistreerd. 
<Connect to Headset> (Verb. met koptelefoon) wordt weergegeven als er een 
geregistreerde koptelefoon aanwezig is. Zie <Een Bluetooth-stereokoptelefoon 
gebruiken> voor meer informatie. Zie pagina 113.

Verbinding maken met een Bluetooth-stereokoptelefoon
U kunt tijdens het afspelen van muziek rechtstreeks verbinding maken 
met de geregistreerde Bluetooth-koptelefoon.
1. Tik op het pictogram [ ] in het 

muziekafspeelscherm.
Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op <Connect to Headset> (Verb. met 
koptelefoon).

Als <Bluetooth Mode> is ingesteld op <Off> (Uit), 
wordt dit gewijzigd in <On> (Aan).
Wanneer de verbinding tot stand is gebracht, ziet u het 
pictogram [  ] op het scherm.
U kunt met de Bluetooth-koptelefoon naar muziek 
luisteren.

De verbinding met de Bluetooth-stereokoptelefoon verbreken
1. Tik op het pictogram [ ] in het muziekafspeelscherm.

Het menu <Music> (Muziek) wordt weergegeven.
2. Tik op <Disconnect Headset> (Headset loskoppelen).

De verbinding met de Bluetooth-koptelefoon is verbroken.

U kunt de <Play Speed> (Afspeelsnelheid), <DNSe> en het <Sound 
Effect> (Geluidseffect) niet selecteren als de speler is verbonden met de 
Bluetooth-headset in muziekmodus.

OPMERKING
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afbeeldingen bekijken
Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij 
controleren.
Druk op het pictogram [ ] om naar het vorige scherm te gaan.
Houd het pictogram [ ] enige tijd ingedrukt om het hoofdmenu weer te geven.

1. Tik op het pictogram  in het hoofdmenu.
Het voorbeeldscherm voor afbeeldingen wordt weergegeven.

2. Selecteer een afbeelding en tik erop.
De geselecteerde afbeelding wordt weergegeven.
Tik op het pictogram [ ] om naar het vorige scherm te gaan.

Naar de vorige/volgende afbeelding gaan
Tik op het pictogram [  ,  ] in het scherm voor afbeeldingsweergave.

De vorige/volgende afbeelding wordt weergegeven.
Informatie en pictogrammen verdwijnen na enige tijd bij de weergegeven afbeelding. 
Tik op het scherm als u deze informatie en pictogrammen weer wilt weergeven.
JPG-bestanden zonder miniatuurweergave of onjuiste miniatuurweergave-informatie 
worden weergegeven [  ].
Sommige afbeeldingen worden langzamer weergegeven dan andere.
Wanneer u een afbeelding naar de speler overbrengt met <EmoDio> (EmoDio), wordt 
het bestand vóór de overdracht geconverteerd naar JPG-indeling. Tevens wordt de 
bestandsgrootte aangepast.
U kunt ook een afbeelding zoeken met behulp van de <File Browser> 
(Bestandsbrowser). Zie pagina 25.
Ook als u <Pictures> (Afbeeld.) selecteert om een afbeelding te bekijken, kunt u 
muziek blijven afspelen.
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HET AFBEELDINGSMENU GEBRUIKEN
Een diashow bekijken
Instructie 1
Tik op het pictogram [ ] in het voorbeeldscherm.

Het pictogram [ ] verschijnt op het scherm en de 
diashow begint.

Instructie 2
1. Tik op het pictogram [ ] in het scherm voor 

afbeeldingsweergave..
Het menu <Pictures> (Afbeeld.) wordt weergegeven.

2. Tik op <Start Slideshow> (Begin diashow).
Het pictogram [ ] verschijnt op het scherm en de 
diashow begint.

De afspeelsnelheid van de diashow instellen
1. Tik op het pictogram [ ] in het scherm voor 

afbeeldingsweergave.
Het menu <Pictures> (Afbeeld.) wordt weergegeven.

2. Tik op <Slideshow Speed> (Snelheid diavoorst.).
Het menu <Slideshow Speed> (Snelheid diavoorst.) 
wordt weergegeven.

3. Tik op de gewenste snelheid.
U kunt kiezen uit <Slow> (Traag), <Normal> (Normaal) 
en <Fast> (Snel).

Tik op het pictogram [ ] om het menu te verlaten.
OPMERKING
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HET AFBEELDINGSMENU GEBRUIKEN (Vervolg)
De diashow beëindigen
Tik op het scherm in de diashowmodus.

De diashow wordt stopgezet.

Een afbeelding als achtergrondafbeelding selecteren
U kunt een afbeelding naar keuze instellen als achtergrond voor het 
scherm.
1. Selecteer een afbeelding om in te stellen als 

achtergrondafbeelding en tik op het pictogram [ ].
Het menu <Pictures> (Afbeeld.) wordt weergegeven.

2. Tik op <Select as My Skin> (Select. als Mijn 
huid).

Het venster Opslaan wordt weergegeven.

3. Tik op <Yes> (Ja).
De geselecteerde afbeelding wordt ingesteld als 
achtergrondafbeelding.
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HET AFBEELDINGSMENU GEBRUIKEN (Vervolg)
De afbeeldingsweergavemodus selecteren
1. Tik op het pictogram [ ] in het scherm voor 

afbeeldingsweergave.
Het menu <Pictures> (Afbeeld.) wordt weergegeven.

2. Tik op <View Mode> (Weergavemodus).
Het menu <View Mode> (Weergavemodus) wordt 
weergegeven.

3. Tik op de gewenste modus.
U kunt kiezen uit <Auto> en <Horizontal> (Horizontaal).
Als u <Horizontal> (Horizontaal) selecteert, wordt de 
afbeelding horizontaal weergegeven.
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HET AFBEELDINGSMENU GEBRUIKEN (Vervolg)
Een afbeelding draaien
U kunt een afbeelding desgewenst draaien.
Instructie 1
1. Tik op het pictogram [ ] in het scherm voor 

afbeeldingsweergave.
Het menu <Pictures> (Afbeeld.) wordt weergegeven.

2. Tik op <Rotate> (Draaien).
Het menu <Rotate> (Draaien) wordt weergegeven.

3. Tik op de gewenste hoek.
U kunt kiezen uit <Left 90°> (Links 90°), <Right 90°> 
(Rechts 90°) en <180°>.

Instructie 2
Plaats uw vingers op het aanraakscherm en 
maak voorzichtig cirkelvormige bewegingen in de 
gewenste richting.

De foto wordt gedraaid.
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HET AFBEELDINGSMENU GEBRUIKEN (Vervolg)
Een afbeelding vergroten
U kunt inzoomen op een afbeelding.
Instructie 1
Tik op het pictogram [ ] in het scherm voor afbeeldingsweergave.

De afbeelding wordt vergroot.
Elke keer dat u op het pictogram [ ] drukt, wordt de 
afbeelding vergroot volgens de stappen <x2>  <x3> 

 <x4>.
Tik op het pictogram [ ] om het vergroten van de 
afbeelding te annuleren.

Instructie 2
Tik twee keer op het scherm waarin de afbeelding 
wordt weergegeven.

Telkens wanneer u twee keer op het scherm tikt, wordt 
de afbeelding vergroot met respectievelijk <x2> -> 
<x3> -> <x4> de grootte.

De vergrote afbeelding weergeven
Instructie 1
Schuif de vergrote foto in de gewenste richting 
wanneer u deze draait.

De afbeelding wordt verplaatst en weergegeven in de 
nieuwe positie.

Instructie 2
1. Tik ergens op het scherm waar geen gegevens 

over de afbeelding of pictogrammen worden 
weergegeven.

Het pictogram [ , , , ] wordt weergegeven.

2. Tik op het pictogram [ , , , ] om 
de afbeelding in de gewenste richting te 
verplaatsen..
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naar de FM-radio luisteren
Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij 
controleren.
Druk op het pictogram [ ] om naar het vorige scherm te gaan.
Houd het pictogram [ ] enige tijd ingedrukt om het hoofdmenu weer te geven.

Tik op het pictogram  in het hoofdmenu.
FM-radio wordt ontvangen.

DE DEMPFUNCTIE GEBRUIKEN
Druk op de toets  terwijl u naar de radio luistert.

Het geluid wordt onderdrukt.
Druk nogmaals op de toets  om het luisteren te hervatten.

Sluit altijd de oortelefoon aan op uw speler als u frequenties 
zoekt of instelt. De oortelefoon wordt gebruikt als antenne 
voor het ontvangen van FM-radio.
In gebieden met slechte ontvangst worden mogelijk geen FM-
stations gevonden.
De Bluetooth-functie kan niet worden gebruikt tijdens het 
luisteren naar de radio.
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FM-STATIONS ZOEKEN
1. Houd het pictogram [ , ] enige tijd ingedrukt en haal uw 

vinger van het scherm in de handmatige modus.
<Searching> (Zoeken,,,) wordt weergegeven op het scherm.
Het zoeken stopt bij de eerstvolgende frequentie nadat u de toets 
hebt losgelaten.

OF,

1. Tik op het pictogram [ , ] om de frequenties stap voor 
stap bij langs te gaan in de handmatige modus.

Wanneer u het pictogram indrukt wordt er naar een frequentie 
gezocht.
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HET MENU FM-RADIO GEBRUIKEN
Overschakelen naar de voorinstellingsmodus
Selecteer deze stand als u de opgeslagen FM-voorinstellingen wilt afzoeken.
1. Tik in de handmatige modus op het pictogram [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op <Go to Preset Mode> (Ga naar Preset Modus).
FM-radio wordt ontvangen.
De <PRESET> wordt op het scherm weergegeven.

Als er geen frequenties zijn voorgeprogrammeerd, wordt 
<Preset list does not exist> (Lijst preselectie bestaat 
niet) weergegeven. De speler schakelt niet over naar de 
voorinstellingsmodus.
Als <Default Set> (Standaard instellen) wordt 
geselecteerd in <Settings> (Instellingen) 
<System> (Systeem), worden de opgeslagen 
voorgeprogrammeerde lijsten verwijderd.
Voorgeprogrammeerde frequenties worden opgeslagen in numerieke volgorde.

Overschakelen naar de handmatige stand
Selecteer deze stand als u de FM-band handmatig 
per frequentie wilt afzoeken.
1. Tik in de voorinstellingsmodus op het pictogram [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op <Go to Manual Mode> (Ga naar Handm.
Modus).

De <MANUAL> (Handm.) wordt op het scherm 
weergegeven.
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Stations opslaan in het voorkeuzegeheugen
U kunt maximaal 30 stations opslaan in het geheugen van uw MP3-
speler en deze vervolgens met één druk op de knop oproepen. Laat de 
MP3-speler met het handmatige proces alleen de zenders kiezen die u 
wilt, of sla automatisch alle gevonden lokale zenders op.
Manual (Handmatig) : alleen de stations kiezen die u wilt opslaan
1. Tik op het pictogram [ , ] om een in te stellen 

frequentie te selecteren in de handmatige modus 
en tik op het pictogram [ ].

2. Tik op <Add to Preset> (Toev. aan voorinst.).
Het geselecteerde station wordt ingesteld als 
voorkeuzestation.

Als een bepaalde frequentie al is 
voorgeprogrammeerd, wordt de melding <This preset 
already exists> (Deze preselectie bestaat reeds) 
weergegeven. De instelling wordt geannuleerd.

Luisteren naar een voorkeuzestation
Tik op het gewenste voorgeprogrammeerde nummer 
in de voorinstellingsmodus.

Het voorgeprogrammeerde nummer wordt 
geselecteerd en u kunt luisteren naar de 
radiofrequentie die is opgeslagen onder dat nummer.
Tik op het pictogram [ , ] om naar de vorige of 
volgende nummerlijst te gaan.

Tik op het pictogram [ ] om het menu te verlaten.
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Stations opslaan in het voorkeuzegeheugen (vervolg)
Automatisch: automatisch alle zenders opslaan die de speler 
ontvangt
1. Tik op het pictogram [ ] in het FM-

radioscherm.
Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op <Auto Preset> (Autom. voorinst.).
Het menu <Auto Preset> (Autom. voorinst.) wordt 
weergegeven.

3. Tik op <Yes> (Ja).
Er worden maximaal 30 frequenties automatisch 
ingesteld.

Automatische voorinstelling annuleren
Als u de automatische voorinstelling wilt annuleren, drukt u tijdens het 
proces op een van de toetsen.

Het automatisch voorprogrammeren wordt geannuleerd en alleen de frequenties 
die tot op dat moment zijn ingesteld, worden opgeslagen.

U kunt de opgeslagen stations opnieuw instellen als u de MP3-speler in 
een andere stad gaat gebruiken. Als u de opgeslagen stations wilt wissen 
en nieuwe wilt laten opslaan, hoeft u het proces slechts te herhalen.
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Een voorkeuzestation wissen 
Volg de onderstaande stappen om frequenties te verwijderen terwijl u 
naar de radio luistert.
1. Tik in de voorinstellingsmodus op het 

pictogram [ ].
Het menu <FM Radio> wordt weergegeven.

2. Tik op <Delete from Preset> (Verw. uit voorpr.).
De voorgeprogrammeerde frequenties worden 
weergegeven.

3. Selecteer een te verwijderen frequentie en tik 
erop.

Het bevestigingsvenster wordt weergegeven.

4. Tik op <Yes> (Ja).
Het geselecteerde voorgeprogrammeerde nummer wordt gewist. 
Als u het voorgeprogrammeerde nummer niet wilt verwijderen, selecteert u 
<No> (Nee).

Als een voorgeprogrammeerde frequentie wordt verwijderd, worden de 
nummers van de volgende voorgeprogrammeerde zenders één stap 
opgeschoven.
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
FM-ontvangst instellen
Met de instelling <FM Sensitivity> (FM Gevoeligheid) kunt u de 
ontvangstgevoeligheid instellen.
1. Tik op het pictogram [ ] in het FM-radioscherm.

Het menu <FM Radio> (FM-radio) wordt weergegeven.
2. Tik op <FM Sensitivity> (FM Gevoeligheid).

Het menu <FM Sensitivity> (FM Gevoeligheid) wordt 
weergegeven.

3. Tik op de gewenste ontvangstgevoeligheid.
U kunt kiezen uit <High> (Hoog), <Middle> (Midden) en 
<Low> (Laag).
Als u <High> (Hoog) selecteert, worden meer frequenties 
ontvangen.

Een FM-regio instellen
U kunt een FM-regio instellen voor reizen naar het buitenland.
1. Tik op het pictogram [ ] in het FM-radioscherm.

Het menu <FM Radio> (FM-radio) wordt weergegeven.
2. Tik op <FM Region> (FM-regio).

Het menu <FM Region> (FM-regio) wordt weergegeven.
3. Tik op de gewenste FM-regio.

U kunt kiezen uit <Korea/US> (Korea/US), <Japan> 
(Japan) en <Other Countries> (Andere Landen).

Frequentiebereik naar regio
- Korea/US (Korea/US) : FM-frequenties in 100 kHz-spelers 

zoeken tussen 87.5 MHz~108.0 MHz.
- Japan : FM-frequenties in 100 kHz-spelers zoeken tussen 76.0 

MHz~108.0 MHz.
- Other Countries (Andere Landen) : FM-frequenties in 50 kHz-

spelers zoeken tussen 87.50 MHz~108.00 MHz.
De FM-regio kan worden verwijderd of gewijzigd overeenkomstig de doelregio 
voor de speler. 
Opgeslagen radiofrequenties worden gewist wanneer u de instelling <FM 
Region> (FM-regio) op de speler wijzigt.
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Een FM-radio-uitzending opnemen
U kunt op elk gewenst moment een FM-radio-
uitzending opnemen terwijl u naar de radio luistert.
1. Selecteer een radiofrequentie die u wilt opnemen 

tik op het pictogram [ ].
Het venster <FM Recording> (FM-opname) wordt 
weergegeven.

2. Tik op <Yes> (Ja).
Er wordt een automatisch gemaakt bestand 
weergegeven en de opname start.

De opname beëindigen
1. Tik tijdens het opnemen op het pictogram [ ].

Het opgenomen bestand wordt opgeslagen in <File 
Browser> (Bestandsbrowser)  <Recorded Files> 
(Opgenomen Bestanden).

U kunt ongeveer 18 uur opnamen maken (op basis 
van 128 Kbps, 1 GB).
U kunt maximaal 999 FM-opnamen opslaan op 
datum.
De bestandsnaam van de opname wordt automatisch 
samengesteld, bijvoorbeeld “FM_JJMMDD_XXX.
MP3”.“FM” betekent FM-opname, “JJMMDD” verwijst 
naar de opnamedatum en “XXX” is het nummer van 
het opnamebestand.

FM Recording

FM Recording

Sweet Music Box
Talk
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de datacast gebruiken
Met <EmoDio> kunt u RSS-bloginformatie en -bestanden naar de speler 
overbrengen.

Wat is RSS?
RSS staat voor Rich Site Summary of Really Simple Syndication. RSS is een op XML 
gebaseerd systeem voor gegevensoverdracht dat wordt gebruikt om eenvoudiger 
informatie weer te geven op websites die vaak worden bijgewerkt, zoals nieuwssites 
en blogs.
Wat zijn datacasts?
U kunt automatisch bijgewerkte informatie ontvangen zonder telkens naar uw 
veelbezochte nieuws-, blog- en UCC-sites te hoeven gaan.
Voordat u begint! - EmoDio moet zijn geïnstalleerd op de computer. Zie pagina 40.

EEN KANAAL REGISTREREN
U kunt een nieuw kanaal maken door websites of webpagina’s met RSS-
ondersteuning te registreren.
1. Klik op <Subscribe> (Aanmelden) onder 

aan het gedeelte <Datacasts> van 
<EmoDio>.

2. Voer een adres in bij <URL> en klik op 
< Next> ( Volgende).

Als u een webadres kopieert en op Subscribe 
<Aanmelden> klikt, wordt het gekopieerde adres 
automatisch weergegeven bij <URL>.
Het venster voor bevestiging van de instellingen 
wordt weergegeven als het webadres 
ondersteuning biedt voor RSS.

3. Klik op <OK>.
Het gewenste kanaal is geregistreerd.
Het pictogram  wordt weergegeven in Datacasts voor het geregistreerde kanaal.

Zie <Datacasts> van <EmoDio> voor meer informatie.
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EEN NIEUWE KANAALGROEP MAKEN
U kunt een nieuwe groep maken om kanalen per categorie te beheren.
1. Klik op <New Group> (Nieuwe groep) onder

aan het gedeelte <Datacasts> van <EmoDio>.
2. Typ een groepsnaam en beschrijving en klik op 

<OK>.

EEN DATACAST OVERBRENGEN VAN <EMODIO>
Voordat u begint! - Sluit de speler aan op de computer. 

EmoDio moet zijn geïnstalleerd op de computer. Zie pagina 40.

1. <EmoDio> wordt automatisch gestart op het 
moment dat de speler wordt aangesloten op de 
computer.

Als het programma niet automatisch wordt 
gestart, dubbelklikt u op het pictogram  van 
<EmoDio> op het bureaublad.

2. Klik op <Datacasts> boven in.
De lijst met groepskanalen voor Datacasts wordt 
weergegeven.

3. Klik op het gewenste groepskanaal.
4. Klik op het gewenste kanaal.
5. Selecteer de melding dat u wilt overbrengen.
6. Klik op het pictogram .

De melding van het geselecteerde kanaal wordt overgebracht naar de speler in <File 
Browser> (Bestandsbrowser)  <Datacasts>.

Klik op  boven in <EmoDio> om naar het vorige scherm te gaan.
Als het bericht een bijlage bevat, kunt u in <Datacasts> in <EmoDio> de bijlage 
downloaden naar de speler. Het kan echter zijn dat de bijlage niet gedownload kan 
worden, afhankelijk van het beleid van de betreffende website.
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DATACASTS WEERGEVEN
U kunt aan <Datacasts> toegevoegde kanaalberichten weergeven.

Voordat u begint! - Breng de gewenste kanaalberichten over naar de speler via 
<EmoDio>. Zie pagina 91.
Druk op het pictogram [ ] om naar het vorige scherm te gaan.
Houd het pictogram [ ] enige tijd ingedrukt om het hoofdmenu weer te geven.

1. Tik op het pictogram  in het hoofdmenu.
De lijst met datacasts wordt weergegeven.

2. Selecteer de gewenste kanaaltitel en tik erop.
De titel is hetzelfde als die van het kanaal dat is toegevoegd aan 
<Datacasts> in <EmoDio>.

3. Selecteer de gewenste berichttitel en tik erop.

De lijst met bestanden wordt weergegeven.

pictogram  : Hoofdtekst van het overgebrachte bericht
pictogram  : Afbeeldingsbestand
pictogram  : Muziekbestand
pictogram  : Videobestand

4. Selecteer een bestand en tik erop.
Het geselecteerde bestand wordt afgespeeld.

OPMERKING
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de extra functies gebruiken
Uw MP3-speler beschikt over diverse extra funcites, zoals de 
mogelijkheid tot het lezen van tekst, het instellen van het alarm en het 
bekijken van de agenda of wereldklok.
TEKST LEZEN
Of het nou gaat om een roman, het manuscript van een nieuw 
verhaal of uw scriptie; u kunt het lezen op uw MP3-speler... 
met uw favoriete muziek op de achtergrond!

Voordat u begint! - De oortelefoon aansluiten, de speler 
aanzetten en de batterij controleren. Breng tekstbestanden 
over naar de speler via <EmoDio>. Zie pagina 41. Stel een
voorkeurstaal voor tekst in via <Settings> (Instellingen)
<Language> (Taal) <Contents> (Inhoud). Zie pagina 32.
Druk op het pictogram [ ] om naar het vorige scherm te gaan.
Houd het pictogram [ ] enige tijd ingedrukt om het 
hoofdmenu weer te geven.

1. Tik op het pictogram  in het hoofdmenu.
De <Prime Pack> (Hoofdpakket)-lijst wordt weergegeven.

2. Selecteer <Texts> (Teksten) en tik erop.
De lijst met tekstbestanden wordt weergegeven.

3. Selecteer een tekstbestand en tik erop.
De tekst wordt op het scherm weergegeven.
Houd uw vinger enige tijd op het aanraakscherm voor weergave
in volledig scherm. Om terug te gaan naar het oorspronkelijke 
scherm, houdt u het aanraakscherm opnieuw even ingedrukt.

U kunt ook een tekstbestand zoeken met behulp van de <File 
Browser> (Bestandsbrowser).
Uw MP3-speler ondersteunt de bestandsindeling TXT in de 
tekstmodus.
Ook als u een tekstbestand selecteert, kunt u naar muziek 
blijven luisteren.

OPMERKING
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HET TEKSTMENU GEBRUIKEN
Naar de vorige/volgende pagina gaan

Instructie 1
Tik op het pictogram [ , ] onder aan het 
aanraakscherm.

Instructie 2
Beweeg uw vinger op het scherm naar links of 
rechts.

Als u uw vinger naar links beweegt, wordt de volgende 
pagina weergegeven. Als u uw vinger naar rechts 
beweegt, wordt de volgende pagina weergegeven.

Een bladwijzer instellen
Stel een bladwijzer in om een volgende keer terug te gaan naar een 
bepaald punt in de tekst.
1. Tik op het pictogram [ ] op de gewenste 

pagina in het tekstweergavescherm.
Het menu <Bookmark> (Bladwijzer) wordt 
weergegeven.

2. Tik op <Add Bookmark> (Bladwijzer toev.).
In het huidige tekstscherm wordt een bladwijzer 
ingesteld en het symbool [ ] wordt linksboven in het 
scherm weergegeven.

Het venster Overschrijven verschijnt als er al 
eerder een bladwijzer is ingesteld. Als u <Yes> (Ja) 
selecteert, wordt de eerder ingestelde bladwijzer 
verwijderd en wordt er een nieuwe bladwijzer 
toegevoegd.
U kunt één bladwijzer per tekstbestand instellen met een maximum van 
100 bladwijzers.

OPMERKING
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HET TEKSTMENU GEBRUIKEN (Vervolg)
Naar de bladwijzer gaan/de bladwijzer verwijderen
1. Tik op het pictogram [ ] in het scherm voor 

tekstweergave.
Het menu <Bookmark> (Bladwijzer) wordt 
weergegeven.

2. Tik op <Go to Bookmark> (Ga naar bladwijzer) 
of <Delete Bookmark> (Bladwijzer verw.).

Als u <Go to Bookmark> (Ga naar bladwijzer) 
selecteert, gaat u naar de geselecteerde bladwijzer. 
Met <Delete Bookmark> (Bladwijzer verw.) verwijdert 
u de geselecteerde bladwijzer uit het tekstbestand.

De kleur van de tekstviewer instellen
Kies in welke kleur u de tekst wilt weergeven.
1. Tik op het pictogram [ ] in het scherm voor 

tekstweergave.
Het menu <Text> (Tekst) wordt weergegeven.

2. Tik op <Text Viewer Color> (Kleur tekstviewer).
Het menuvenster <Text Viewer Color> (Kleur 
tekstviewer) wordt weergegeven.

3. Tik op het pictogram [  , ] om een kleur voor 
de tekstviewer te selecteren.

U kunt kiezen uit <Type 1> tot en met <Type 7>.

4. Tik op <OK>.
De geselecteerde kleur voor de tekstviewer wordt weergegeven.

Texts 1 7.0%
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HET TEKSTMENU GEBRUIKEN (Vervolg)
De lettergrootte wijzigen
U kunt de lettergrootte van de tekst wijzigen.
1. Tik op het pictogram [ ] in het scherm voor 

tekstweergave.
Het menu <Text> (Tekst) wordt weergegeven.

2. Tik op <Font Size> (Lettergr.).
Het menu <Font Size> (Lettergr.) wordt weergegeven.

3. Tik op het pictogram [  ,  ] om de gewenste 
lettergrootte te selecteren.

U kunt kiezen ui <Small> (Klein), <Medium> en 
<Large> (Groot).

4. Tik op <OK>.
De lettergrootte is gewijzigd.

My doggy likes to disco dance.

He boogies every night.

He dances in his doghouse

till the early morning light.

The other dogs come running

when they hear my doggy swing.
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HET TEKSTMENU GEBRUIKEN (Vervolg)
De tekstweergavemodus instellen
U kunt tekst horizontaal of verticaal weergeven.
Instructie 1
1. Tik op het pictogram [ ] in het scherm voor 

tekstweergave.
Het menu <Text> (Tekst) wordt weergegeven.

2. Tik op <View Mode> (Weergavemodus).
Het menu <View Mode> (Weergavemodus) wordt 
weergegeven.

3. Tik op <Horizontal> (Horizontaal).
Het tekstscherm wordt gedraaid en horizontaal 
weergegeven.
Tik op <Vertical> (Verticaal) om het scherm verticaal 
weer te geven.

Instructie 2
Plaats uw vingers op het aanraakscherm en maak 
voorzichtig cirkelvormige bewegingen in de gewenste 
richting.

Hiermee draait u het scherm in de horizontale of 
verticale weergavemodus.
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till the early morning light.
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VIDEOSPELLETJES SPELEN
Op uw mp3-speler staan al spannende spelletjes!

Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij 
controleren.

1. Tik op het pictogram  in het hoofdmenu.
De <Prime Pack> (Hoofdpakket)-lijst wordt weergegeven.

2. Selecteer <Games> (Spel) en tik erop.
De lijst met spellen wordt weergegeven.

3. Selecteer het gewenste spel en tik erop.

Druk op de knop [ ] om een spelgeluid voor of de 
huidig muziek als achtergrondmuziek weer te geven.Als 
u een muziekbestand selecteer om af te spelen, kan de 
navigatie van het spel wat trager zijn, afhankelijk van het 
gebruik van het Bluetooth-apparaat of het bestand.

Bubble Smile
U moet een zo hoog mogelijke score behalen door de volgorde van drie 
zeepbellen te veranderen en deze horizontaal of 
diagonaal te combineren.
Draai de drie aangrenzende zeepbellen op 
volgorde links- of rechtsom.
De zeepbel wordt verplaatst in de geselecteerde 
richting.
U krijgt alleen punten wanneer u ten minste drie 
zeepbellen combineert.
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VIDEOSPELLETJES SPELEN (Vervolg)
World Car Puzzle
U hebt de kans om te genieten van ‘s werelds meest beroemde auto’s 
terwijl u de mozaïekstukjes aan elkaar probeert te leggen.
Het spel wordt weergegeven in de 
horizontale weergave.
Selecteer de gewenste auto het, aantal 
puzzelstukjes en tips, de vorm en de 
tijdslimiet.
Tik op een puzzelstukje en hou deze vast 
om het vervolgens naar de gewenste 
positie te slepen voordat u het loslaat.
Het puzzelstukje wordt naar de gewenste locatie verplaatst.

ALGGAGI
Om dit spel te winnen, moet u alle stukken van de tegenstander op het 
schaakbord verwijderen door deze met uw stukken te raken.
Het spel wordt weergegeven in de 
horizontale weergave.
Schuif een van uw stukken in de richting 
van een stuk van uw tegenstander om 
deze van het schaakbord te verwijderen.
Als u niet binnen de gestelde tijd een 
van uw stukken hebt verplaatst, gaat de 
beurt naar de tegenstander.

Als u het speelscherm tijdens het spel wilt sluiten, tikt u in de 
linkerbenedenhoek van het aanraakscherm.OPMERKING
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VIDEOSPELLETJES SPELEN (Vervolg)
Omok2
Om dit spel te winnen, moet u een ononderbroken horizontale, verticale 
of diagonale rij van vijf stenen zien te maken, voordat uw tegenstander 
dit lukt.
Het spel wordt weergegeven in de 
horizontale weergave.
Tik op het gebied waar u de steen wilt 
plaatsen, zodat het gebied vergroot 
wordt weergegeven.
Tik in het vergrote gebied op de exacte 
positie waar u de steen wilt plaatsen.
Uw steen wordt op de betreffende positie geplaatst.Als u niet binnen de 
gestelde tijd een van uw stukken hebt verplaatst, gaat de beurt naar de 
tegenstander.

Als u het speelscherm tijdens het spel wilt sluiten, tikt u in de 
linkerbenedenhoek van het aanraakscherm.

Pow Wow
Dit is een schietspel waarbij punten kunt scoren 
door een bewegend doel te raken.
Tik op het bewegende doel.
Als u het geweer opnieuw wilt laden, tikt u op het 
scherm op <Reload> (Herladen).

OPMERKING
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VIDEOSPELLETJES SPELEN (Vervolg)
Met 2 spelers spelen in de Bluetooth-modus

Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de 
batterij controleren.
Als de speler via Bluetooth verbinding heeft gemaakt met een stereo headset, 
mobiele telefoon of een extern apparaat, moet u om te beginnen de verbinding 
uitschakelen. Tik achtereenvolgens op <Bluetooth>  <Bluetooth Mode> en 
<On> (Aan). Selecteer <Discoverable> (Zichtbaar)  <Bluetooth Settings> 
(Bluetooth Instellingen)  <Discover option> (Optie-ontdekking).

1. Voer hetzelfde spel uit (<Omok2>
of <AlGGAGI>) op de twee YP-P2-
modellen en selecteer de modus 
<Double> (Dubbel).

De Bluetooth-schermen <Connect> 
(Verbinden) en <Wait> (Wachten) worden 
weergegeven.

2. Selecteer <Wait> (Wachten) op een 
van de speler en selecteer <Connect> 
(Verbinden) op de andere speler.

YP-P2 wordt weergegeven op de YP-P2 waar op <Connect> (Verbinden is 
geselecteerd).

3. Tik op <YP-P2> op de YP-P2 waarop 
<Connect> (Verbinden) is geselecteerd.

De Bluetooth-verbinding wordt tot stand 
gebracht en de beide spelers kunnen tegen 
elkaar spelen.

Wanneer de speler verbinding maakt met 
de Bluetooth-stereoheadset, kunnen de 
twee spelers niet via Bluetooth tegen elkaar 
spelen.

Voorbeeld) Alggagi – Scherm voor het 
selecteren van de modus

Voorbeeld) Bluetooth-scherm voor 
wachten/verbinden

OPMERKING
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HET ALARM INSTELLEN
Deze speler heeft een alarm dat  u zo kunt instellen, dat deze afgaat op een 
gepland tijdstip.

Voordat u begint! - Eerst moet u de klok op de huidige tijd instellen. Zie pagina 33.

1. Tik op het pictogram  in het hoofdmenu.
Het menu <Prime Pack> (Hoofdpakket) wordt weergegeven.

2. Selecteer <Alarm> (Alarm) en tik erop.

3. Tik op <New Alarm> (Nieuw alarm).
Het venster voor de alarminstellingen wordt weergegeven.

4. Tik meerdere keren op het eerste item om de frequentie 
van het alarm te selecteren.

U kunt kiezen uit <Once> (Eenmalig), <Everyday> (Elke dag), 
<Mon~Fri> (Maan-Vrijd), <Mon~Sat> (Maan-Zat), <Sat~Sun> 
(Zat-Zon) en <Off> (Uit).

5. Tik op het tweede item
Het scherm voor instelling van de alarmtijd wordt 
weergegeven.

Once

12 : 40 AM

Alarm Sound 1

Interval : 5min

Alarm

Prime Pack

Texts

Games

Alarm

Calendar

Address Book

World Clock

Calculator

Record
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Alarm

OK Cancel

HET ALARM INSTELLEN (Vervolg)
6. Stel de uren, minuten en AM/PM in door omhoog of 

omlaag te gaan.

7. Tik op <OK>.

8. Tik meerdere keren op het derde item om het 
alarmgeluid te selecteren.

U kunt kiezen uit <Alarm Sound 1> (Alarmgeluid 1) tot en met 
<Alarm Sound 3> (Alarmgeluid 3) of muziekbestanden die zijn 
toegevoegd als alarmgeluid. Zie pagina 74.

9. Tik meerdere keren op het vierde item om het 
alarminterval in te stellen.

Als het interval is ingesteld, wordt het alarm herhaald volgens 
het ingestelde interval. U kunt kiezen uit <Interval: 3min> (interval : 3min), <Interval: 
5min> (interval : 5min) en <Interval: 10min> (interval : 10min).

10. Tik op <OK>.
Het bevestigingsvenster voor opslaan wordt weergegeven.

11. Tik op <Yes> (Ja).
De alarminstelling wordt toegevoegd aan de alarmlijst.

U kunt maximaal 7 alarmen instellen.
OPMERKING
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HET ALARM INSTELLEN (Vervolg)
De alarminstelling bewerken
1. Selecteer in het alarmscherm een alarminstelling 

die u wilt wijzigen, en tik erop.
Het venster voor de alarminstellingen wordt 
weergegeven.

2. Volg dezelfde stappen als de nieuwe 
alarminstellingen hierboven om de instelling te 
wijzigen. Zie pagina 102.

Een alarminstelling verwijderen
1. Tik in het alarmscherm op een te verwijderen 

alarminstelling.
2. Klik op het pictogram [ ].

Tik op het pictogram [ ] om alle alarminstellingen te 
verwijderen.
Het venster Wissen wordt weergegeven.

3. Klik op <Yes> (Ja).
Het geselecteerde alarm wordt verwijderd.

Het alarm gaat op de ingestelde tijd af. Tik op <Alarm Off> (Alarm uit) om het alarm te 
stoppen. Als u het alarm weer wilt weergeven, tikt u op het alarminterval.

De alarmfunctie werkt niet als de USB-kabel op de speler is aangesloten.

OPMERKING
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Once

12 : 40 AM

Alarm Sound 1

Interval : 5min
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DE AGENDA BEKIJKEN
U kunt de agenda bekijken.

Voordat u begint! - Eerst moet u de klok op de huidige tijd instellen. Zie pagina 33.

1. Tik op het pictogram  in het hoofdmenu.
Het menu <Prime Pack> (Hoofdpakket) wordt weergegeven.

2. Selecteer <Calendar> (Agenda) en tik erop.
Het menu <Calendar> (Agenda) wordt weergegeven.

3. Tik op het pictogram [ , ] om de gewenste maand te 
selecteren.

Het type agenda instellen
U kunt de agenda op twee manieren weergeven.
1. Tik op het pictogram [ ] in het scherm voor 

agendaweergave.
Het menu <Calendar> (Agenda) wordt weergegeven.

2. Tik op <View Type> (Weergavetype).
Het scherm <View Type> (Weergavetype) wordt 
weergegeven.

3. Tik op het pictogram [  ,  ] om de gewenste 
weergavemodus te selecteren en tik op <OK>.

U kunt kiezen uit <Type 1> (Type 1) of <Type 2> (Type 2).
Bij <Type 1> wordt zondag tot en met zaterdag 
weergegeven, bij <Type 2> maandag tot en met 
zondag.

SUN MON    TUE    WED    THU    FRI SAT

1         2          3          4         5 6

 7         8         9         10        11       12      13

14       15       16        17        18       19 20

21       22       23        24        25       26 27

28       29       30        31

View Type

 Type 1

OK Cancel

Prime Pack

Texts

Games

Alarm

Calendar

Address Book

World Clock

Calculator

Record
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HET ADRESBOEK BEKIJKEN
U kunt het adresboek downloaden met behulp van de Bluetooth-functie om het 
telefoonnummer te controleren en de andere persoon op de speler direct te bellen.

Voordat u begint! - Gebruik eerst de op Bluetooth gebaseerde bestandsoverdracht 
om het adresboek van een extern apparaat te downloaden. Zie <Een bestand van het 
externe apparaat naar de speler overbrengen> voor meer informatie. Zie pagina 126.
U moet uw mobiele telefoon koppelen met de speler voordat u een nummer belt in het 
venster adresboek.
Zie <Een mobiele telefoon met bluetooth gebruiken> voor meer informatie. Zie pagina 116.

1. Tik op het pictogram  in het hoofdmenu.
Het menu <Prime Pack> (Hoofdpakket) wordt weergegeven.

2. Selecteer <Address Book> (Adresboek) en tik erop.
Het venster <Address Book> (Adresboek) wordt weergegeven.

3. Selecteer een naam die u wilt controleren in het venster 
<Address Book> (Adresboek) en tik erop.

De geselecteerde adresgegevens worden weergegeven.

Een nummer bellen in het adresboek
1. Selecteer een naam waarvan u het nummer wilt bellen in het venster 

Adresboek en tik erop.
De geselecteerde adresgegevens worden weergegeven.

2. Selecteer het gewenste telefoonnummer en tik op het pictogram [ ].
Het gewenste telefoonnummer wordt nu gekozen.

Het adresboek wordt weergegeven in alfabetische volgorde.
De adresboekbestanden die naar de speler zijn overgebracht, worden opgeslagen in de 
map <File Browser> (Bestandsbrowser)  <Received Files> (Ontvangen bestanden).
Alleen de vCard-bestandsindeling wordt ondersteund voor het adresboek.

OPMERKING
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DE WERELDKLOK WEERGEVEN
U kunt de locatie en datum/tijd van grote wereldsteden bekijken op basis van de 
respectievelijke tijdzone.

Voordat u begint! - Eerst moet u de klok op de huidige tijd instellen Zie pagina 33.
Stel de gewenste tijdzone in via <Settings> (Instellingen) <Time> (Tijd) 
<Time Zone> (Tijdszone).

1. Tik op het pictogram  in het hoofdmenu.
Het menu <Prime Pack> (Hoofdpakket) wordt weergegeven.

2. Selecteer <World Clock> (Wereldklok) en tik erop.
Het scherm <World Clock> (Wereldklok) wordt weergegeven.

3. Tik op het pictogram [ , ] om een tijdzone te 
selecteren.

U kunt de datum/tijd van de door u geselecteerde stad 
weergeven.

U kunt de lokale tijd van de volgende tijdzones bekijken. 
(‘/’ geeft de standaard tijdzone in de regio weer)
Cape Verde, London/Lisbon, Rome/Paris, Athens/Helsinki, Moscow/Riyadh, 
Abu Dhabi/Muskat, Tashkent/Ashgabat, Alma Ata/Kathmandu, Bangkok/Jakarta, 
Hongkong/Beijing, Seoul/Tokyo, Guam/Sydney, Okhotsk, Wellingtons/Oakland, 
Samoa/Midway, Honolulu/Hawaii, Alyeska, Los Angeles/Seattle, Denver/Phoenix, 
Chicago/Mexico City, New York/Miami, Caracas/Santiago, Buenos Aires/Brasilia, 
The middle Atlantic 
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DE REKENMACHINE GEBRUIKEN
De rekenmachines helpt u bij de vier regels van de rekenkunde (optellen, 
aftrekken, vermenigvuldigen en delen).

Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en 
de batterij controleren.

1. Tik op het pictogram  in het hoofdmenu.
Het menu <Prime Pack> (Hoofdpakket) wordt weergegeven.

2. Selecteer <Calculator> (Rekenmachine) en tik erop.
Het scherm met de rekenmachine wordt weergegeven.

3. Maak een rekensom door op de cijfers op het scherm te 
tikken.

Calculator

Prime Pack
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STEMOPNAME
Hiermee kunt u een stemopname maken.

Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij 
controleren.

Een stemopname maken

1. Tik op het pictogram  in het hoofdmenu.
Het menu <Prime Pack> (Hoofdpakket) wordt 
weergegeven.

2. Selecteer <Record> (Opnemen) en tik erop.
Het scherm Spraakopname wordt weergegeven.

3. Klik op het pictogram [ ].
Het bevestigingsvenster voor opnemen wordt 
weergegeven.

4. Klik op <Yes> (Ja).
De opname begint en het scherm wordt automatisch 
uitgeschakeld voor een betere opnamekwaliteit.

Plaats de microfoon niet te ver weg of te dichtbij uw mond tijdens de 
opname. Dit kan ten koste gaan van de opnamekwaliteit. 
Stemopname werkt niet goed als de batterij bijna leeg is.

Prime Pack
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STEMOPNAME (Vervolg)
De stemopname beëindigen

1. Druk tijdens het opnemen op de toets [ ].
Het scherm wordt weer ingeschakeld en het 
opgenomen bestand wordt opgeslagen.

Het opgenomen bestand wordt opgeslagen in 
<File Browser> (Bestandsbrowser)  <Recorded Files> (Opgenomen 
Bestanden).
U kunt ongeveer 18 uur opnamen maken (op basis van 128 Kbps, 1 GB)
U kunt maximaal 999 bestanden voor spraakopname opslaan per datum.
Elk spraakopnamebestand is maximaal 5 uur lang.
De bestandsnaam van de opname wordt automatisch samengesteld, 
bijvoorbeeld “VCE_JJMMDD_XXX.mp3”. “VCE” betekent spraakopname, 
“JJMMDD” verwijst naar de opnamedatum en “XXX” is het nummer van het 
opnamebestand.

Record Voice

OPMERKING
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WERELDKAART METRO WEERGEVEN
U kunt door de wereldkaart van de metro en bekende plaatsen in de buurt van 
het station bladeren stations.

1. Tik op het pictogram  in het hoofdmenu.
Het menu <Prime Pack> (Hoofdpakket) wordt weergegeven.

2. Selecteer <Subway Route Map> (Routekaart metro) en 
tik erop.

Er verschijnt een scherm waarin u een wereldregio kunt 
selecteren.

3. Tik op de gewenste regio.
U kunt kiezen uit <AMERICA> (AMERIKA), <EUROPE> 
(EUROPA), <ASIA/OCEANIA> (AZIË/OCEANIË).
Er worden steden in de geselecteerde regio weergegeven 
waarvoor metrokaarten beschikbaar zijn.

4. Tik op de stad om de metrokaart weer te geven.
De metrokaart van de geselecteerde stad wordt weergegeven.

5. Als u de kaart wilt vergroten, tikt u op het gedeelte dat u wilt vergroten.
Tik nogmaals op de vergrote kaart om de pictogrammen [ ] weer te geven 
en verplaats de kaart met deze knoppen.
Als er zich interessante plaatsen in de nabijheid van het station bevinden op de 
vergrote kaart, tikt u op het pictogram om de informatie hiervoor weer te geven.

Tik op het pictogram [ ] om terug te keren naar het scherm met e wereldregio’s.
Als u op het pictogram [ ] tikt, keert u terug naar het vorige scherm en wanneer u 
het pictogram [ ] ingedrukt houdt, keert u terug naar het hoofdmenu.
De kaart kan afwijken van de werkelijke metrokaart.

OPMERKING
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Bluetooth gebruiken
Druk op het pictogram [ ] om naar het vorige scherm te gaan.
Houd het pictogram [ ] enige tijd ingedrukt om het hoofdmenu weer te geven.

WAT IS BLUETOOTH?
Bluetooth is een industriestandaard voor draadloze PAN’s (personal area networks). 
Bluetooth biedt verbinding en uitwisseling tussen apparaten als mobiele telefoons, 
laptops, pc’s, printers, digitale camera’s en videospelcomputers via een beveiligde, 
wereldwijd ongelicentieerde korte golf radiofrequenties.

Afhankelijk van de gebruiksomstandigheden kunnen Bluetooth-apparaten ruis of 
storingen veroorzaken.

Fysieke signaalstoringen, zoals wanneer u de speler in de hand houdt en een 
stereokoptelefoon draagt.
Wanneer een deel van het lichaam in contact is met het ontvangstsysteem van de speler of 
de stereokoptelefoon.
Spanningsvariatie als gevolg van elektrische storing door muren, hoeken of 
scheidingswanden.
Elektrische interferentie door apparatuur die dezelfde frequentie gebruikt, bijvoorbeeld 
medische apparatuur, magnetrons en draadloze LAN’s.

Houd de afstand tussen het Bluetooth-apparaat en de speler zo klein mogelijk.
Hoe groter de afstand tussen de speler en de stereokoptelefoon, des te slechter de 
kwaliteit. Als de afstand de limiet overschrijdt, wordt de verbinding verbroken.
We raden af om de tekst- en afbeeldingsmodi te gebruiken terwijl u naar muziek 
luistert via de stereokoptelefoon. Dit verslechtert zowel de prestaties van de speler 
als de Bluetooth-communicatie.
Bestanden met minder dan 32 kHz kunnen niet worden afgespeeld, afhankelijk van 
het model stereokoptelefoon.
In gebieden met een slechte ontvangst, bijvoorbeeld in een lift of ondergronds, 
werkt de Bluetooth-verbinding mogelijk niet goed.
De maximumafstand voor draadloze verbinding tussen de speler en een Bluetooth-
apparaat is 10 meter. Als de afstand groter wordt, wordt de verbinding automatisch 
verbroken. Zelfs binnen dit bereik kan de geluidskwaliteit verslechteren door 
obstakels zoals muren of deuren.

OPMERKING
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Bluetooth

Stereo Headset

Mobile Phone

File Transfer

Bluetooth Mode

Bluetooth Settings

EEN BLUETOOTH-STEREOKOPTELEFOON GEBRUIKEN
U kunt een Bluetooth-stereokoptelefoon gebruiken om draadloos van muziek te 
genieten met stereogeluid van een hoge kwaliteit.

Voordat u begint! - Als de speler via Bluetooth verbinding heeft gemaakt met een 
mobiele telefoon of een extern apparaat, moet u om te beginnen 
de verbinding uitschakelen. Zorg ervoor dat het Bluetooth-
apparaat dat u wilt aansluiten klaar is om te worden gekoppeld. 
(raadpleeg de gebruikshandleiding van het apparaat)

De Bluetooth-stereokoptelefoon registreren
(U hoeft dit product slechts één keer te registreren)

1. Tik op het pictogram  in het hoofdmenu.
Het venster voor het instellen van Bluetooth wordt 
weergegeven.

2. Tik op <Yes> (Ja).
De <Bluetooth Mode> (Bluetooth Mode) is ingesteld 
op <On> (Aan).
Het pictogram  licht op.

3. Maak de stereo-koptelefoon gereed voor 
koppeling.

Raadpleeg de producthandleiding om de koptelefoon 
gereed te maken voor de koppeling.

4. Tik op <Stereo Headset> (Stereo Koptelefoon).

5. Klik op het pictogram [ ].
Deze speler zoekt automatisch naar Bluetooth-
apparaten, ook als er niet op het pictogram [ ] is 
gedrukt.
De te registreren koptelefoon wordt in de lijst 
opgenomen.
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EEN BLUETOOTH-STEREOKOPTELEFOON GEBRUIKEN (Vervolg)
De Bluetooth-stereokoptelefoon registreren (vervolg)
6. Tik op de naam van de koptelefoon die u wilt registreren.

Het venster voor het invoeren van het wachtwoord wordt weergegeven als 
het wachtwoord voor de koptelefoon anders is dan 0000. Raadpleeg de 
handleiding van de koptelefoon voor het wachtwoord.
De registratie van de koptelefoon is voltooid.

U kunt de Bluetooth-functie alleen gebruiken voor het afspelen van muziek, 
videobestanden en spellen. Er is geen ondersteuning voor het luisteren 
naar FM-radio.
Beschrijving van het Bluetooth-pictogram

: Bluetooth-modus uit : Bluetooth-modus aan

: Verbonden met een stereo-koptelefoon :Verbonden met een mobiele telefoon

U kunt de Bluetooth-functie uitschakelen via <Bluetooth> (Bluetooth) 
<Bluetooth Mode>  <Off> (Uit).
Gebruik alleen stereo-koptelefoons die zijn gecertifi ceerd voor Bluetooth. 
Handsfree mono-koptelefoons worden niet ondersteund.
Schakel de <Bluetooth Mode> naar <Off> (Uit) als deze niet in gebruik is. 
Als u de <Bluetooth Mode> in de stand <On> (Aan) laat staan, loopt de 
batterij sneller leeg.
U kunt maximaal 20 apparaten toevoegen voor de Bluetooth-verbinding.
Sommige Bluetooth-stereokoptelefoons kunnen slecht communiceren met 
uw speler, afhankelijk van het model.
De Bluetooth-functie van de speler is optimaal afgestemd op Samsung-producten. 
In combinatie met andere producten, werkt de Bluetooth-functie mogelijk niet 
correct.
Gebruik de Bluetooth-functie niet voor illegale doeleinden (illegale kopieën, 
illegaal gebruik van draadloze netwerken, enzovoort voor commerciële 
doeleinden). Samsung is niet verantwoordelijk voor dergelijk illegaal 
gebruik en de gevolgen daarvan.

OPMERKING
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EEN BLUETOOTH-STEREOKOPTELEFOON GEBRUIKEN (Vervolg)
Verbinding maken met de geregistreerde Bluetooth-
stereokoptelefoon
1. Tik op het pictogram  in het hoofdmenu.
2. Tik op <Stereo Headset> (Stereo Koptelefoon).
3. Tik op de stereokoptelefoon om verbinding te 

maken.
Wanneer de verbinding tot stand is gebracht, ziet u het 
pictogram [ ] op het scherm.
U kunt verbinding maken met maximaal twee 
koptelefoons.

4. Speel het gewenste bestand af.
U kunt met een stereo-koptelefoon naar muziek 
luisteren.

Als u de gewenste koptelefoon niet kunt vinden, moet u deze eerst 
registreren. Zie pagina 113.
De Bluetooth-verbinding wordt verbroken als u de speler of de koptelefoon 
uitschakelt en na een seconde weer inschakelt. Herhaal de bovenstaande 
instructies als u met de stereo-koptelefoon naar muziek wilt luisteren.
Als er verbinding is met twee koptelefoons, kan alleen de koptelefoon 
waarmee het eerst verbinding is gemaakt, worden ingeschakeld voor 
functionele bediening zoals afspelen/stoppen en volumeregeling. 
Raadpleeg de handleiding van de koptelefoon voor meer informatie.
Headsets die geschikt zijn voor Bluetooth

Fabrikant Model Fabrikant Model
Plantronics PULSAR 590 LUBIX NC1

wiREVO S300 SAMSUNG SBH-170
Sony Ericsson HBH-DS970 Jabra BT-620S

SONY DR-BT30Q Motorola HT-820
Fusion NFC BT-55D

Stereo Headset

SBH-170

OPMERKING
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Bluetooth

Stereo Headset

Mobile Phone

File Transfer

Yes

Connect?

No

EEN MOBIELE TELEFOON MET BLUETOOTH GEBRUIKEN
Wanneer u een mobiele telefoon met Bluetooth aansluit, kunt u 
telefoongesprekken voeren en ontvangen met uw speler. De speler functioneert 
als een handsfree apparaat.

Voordat u begint! - Als de speler via Bluetooth verbinding heeft gemaakt met 
een stereo-koptelefoon of een extern apparaat, moet u om 
te beginnen de verbinding uitschakelen.Zorg ervoor dat de 
mobiele telefoon met Bluetooth die u wilt aansluiten, klaar is 
om te worden gekoppeld. (Raadpleeg de gebruiksaanwijzing 
van de mobiele telefoon.) Selecteer <Discoverable> (Zichtbaar) 
in <Bluetooth Settings> (Bluetooth Instellingen)  <Discover 
Option> (Optie-ontdekking). Zie pagina 128.

De mobiele telefoon met Bluetooth registreren
(U hoeft dit product slechts één keer te registreren)
1. Tik op het pictogram  in het hoofdmenu.

Het venster voor het instellen van Bluetooth wordt 
weergegeven.

2. Tik op <Yes> (Ja).
De <Bluetooth Mode> is ingesteld op <On> (Aan).
Het pictogram  licht op.

3. Zoek de YP-P2 in het menu van uw mobiele 
telefoon.

Als u de YP-P2-speler een nieuwe naam hebt 
gegeven, zoekt u naar de nieuwe naam.

4. Voer het wachtwoord in wanneer op de mobiele 
telefoon het invoervenster voor het wachtwoord wordt weergegeven.

5. Tik op <Yes> (Ja) als u het bericht <Connect?> (Aansluiten?) ziet.
Het invoervenster voor de PIN-code (wachtwoord) wordt weergegeven.

De wachtwoordcijfers kunnen variëren, afhankelijk van de mobiele 
telefoon. (raadpleeg de gebruiksaanwijzing van de mobiele telefoon)OPMERKING
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EEN MOBIELE TELEFOON MET BLUETOOTH GEBRUIKEN 
(Vervolg)

De mobiele telefoon met Bluetooth registreren (Vervolg)
6. Voer het wachtwoord in voor de mobiele telefoon 

die u aan de speler wilt toevoegen.
Voer hetzelfde wachtwoord in als bij stap 4 hierboven.

7. Tik op <OK>.
De registratie van de mobiele telefoon is voltooid.

Bij sommige mobiele telefoons werken de functies voor toestel zoeken en 
mobiele conversaties (bellen/gebeld worden) niet correct.
Als u een toets op de mobiele telefoon indrukt of belt of het bellen beëindigt 
terwijl de speler via Bluetooth met de mobiele telefoon is verbonden, kan er 
ruis in de speler optreden.
We raden u aan een Engelse apparaatnaam voor de mobiele telefoon te 
gebruiken.
Mobiele telefoons die geschikt zijn voor Bluetooth

Fabrikant Model

SAMSUNG
SPH-C3250, SPH-W2700, SPH-V7400, SPH-V6900, SCH-W270,
SPH-B5600, SPH-B3200, SGH-X828, SGH-I718, SGH-E908, SGH-U608

LG LG-KH1000, LG-KV2400, LG-KG90, LG-KG77
SKY IM-U130

NOKIA N72
PHILIPS S900

MOTOROLA Z3

OPMERKING
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Mobile Phone

Mobile Phone

Redial

Call by Number

Call History

EEN MOBIELE TELEFOON MET BLUETOOTH GEBRUIKEN 
(Vervolg)

Verbinding maken met de geregistreerde mobiele 
telefoon met Bluetooth
1. Tik op het pictogram  in het hoofdmenu.

2. Selecteer <Mobile Phone> (GSM) in het scherm 
Bluetooth.

3. Selecteer <Mobile Phone> (GSM) en tik erop.

4. Selecteer een GSM waarmee u een verbinding 
wilt maken en tik erop.

Wanneer de verbinding tot stand is gebracht, ziet u het 
pictogram  op het scherm.

Als u geen toestel kunt vinden om verbinding mee te maken, moet u het 
toestel eerst op de speler registreren. Zie pagina 116.
De mobiele-telefoonverbinding kan worden uitgeschakeld wanneer u 
speler uit- en weer inschakelt.Als dat het geval is, herhaalt u bovenstaande 
stappen om de verbinding opnieuw tot stand te brengen.

OPMERKING
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EEN MOBIELE TELEFOON MET BLUETOOTH GEBRUIKEN 
(Vervolg)

Het laatst gebruikte nummer kiezen

1. Selecteer <Mobile Phone> (GSM) in het scherm 
Bluetooth.

2. Selecteer <Redial> (Opnieuw bellen) en tik erop.
Het laatst gebruikte telefoonnummer wordt nu gekozen.

De recente oproepgeschiedenis wordt weergegeven, 
afhankelijk van de mobiele telefoon. Selecteer het laatste 
telefoonnummer in de oproepgeschiedenis om te bellen.

Bellen met de speler
1. Selecteer <Mobile Phone> (GSM) in het scherm 

Bluetooth.
2. Selecteer <Call by Number> (Met toetsen bellen) en 

tik erop.
Het invoervenster voor het telefoonnummer wordt 
weergegeven.

3. Voer het telefoonnummer van de andere persoon in.
4. Tik op het pictogram [  ].

Het gewenste telefoonnummer wordt nu gekozen. 

Als er op de aangesloten GSM sneltoetsen zijn ingesteld, 
kunt u direct op de speler een nummer kiezen door het 
laatste cijfer van de sneltoets ingedrukt te houden.

Het telefoongesprek beëindigen
Tik op <Disconnect> (Afsluiten) tijdens het voeren van gesprekken.

Het telefoongesprek wordt beëindigd.

Mobile Phone

Mobile Phone

Redial

Call by Number

Call History

Mobile Phone

Mobile Phone

Redial

Call by Number

Call History

OPMERKING
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EEN MOBIELE TELEFOON MET BLUETOOTH GEBRUIKEN 
(Vervolg)

Bellen met behulp van de lijst met telefoonnummers

1. Selecteer <Mobile Phone> (GSM) in het scherm 
Bluetooth.

2. Selecteer <Call History> (Oproepgeschiedenis) 
en tik erop.

De lijst met telefoonnummers wordt weergegeven.

3. Selecteer het gewenste telefoonnummer en tik 
op het pictogram [ ].

Het gewenste telefoonnummer wordt nu gekozen.

Een telefoonnummer uit de lijst met telefoonnummers 
verwijderen

1. Selecteer een telefoonnummer dat u wilt verwijderen onder <Call
History> (Oproepgeschiedenis) en tik op het pictogram [ ].

2. Tik op <Delete> (Wissen).
Als u alle nummers uit de lijst met telefoonnummers wilt verwijderen, 
selecteert u <Delete All> (Alles verwijderen).

Het bevestigingsvenster wordt weergegeven.

3. Tik op <Yes> (Ja).
Het geselecteerde nummer wordt verwijderd.

Mobile Phone

Mobile Phone

Redial

Call by Number

Call History
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EEN MOBIELE TELEFOON MET BLUETOOTH GEBRUIKEN 
(Vervolg)

De telefoon opnemen

1. Wanneer u wordt gebeld, wordt <Connect?> (Aansluiten?) 
weergegeven.

2. Tik op <Yes> (Ja).
U kunt nu spreken.

Overschakelen op de mobiele telefoon terwijl u via de speler 
(YP-P2) in gesprek bent

Tik op <Voice to Phone> (Geluid naar Tel.) terwijl u via de speler 
spreekt.

U kunt nu het gesprek via de mobiele telefoon voortzetten.

Overschakelen op de speler (YP-P2) terwijl u via de mobiele 
telefoon in gesprek bent

Tik op <Voice to Hands-free> (Geluid nr Handsfr.) terwijl u via de GSM 
spreekt.

U kunt nu het gesprek via het handsfree apparaat voortzetten.

Het volume wijzigen

Terwijl u op het handsfree apparaat in gesprek bent, tikt u op de knop 
[ +, – ] om het volume aan te passen.

U kunt het volume instellen van 0 tot 30.



122 _ Bluetooth gebruiken

Bluetooth

Stereo Headset

Mobile Phone

File Transfer

Bluetooth Mode

Bluetooth Settings

BESTANDEN OVERBRENGEN NAAR/VAN EEN 
BLUETOOTH-APPARAAT
U kunt muziek-, foto- en fi lmbestanden van voor Bluetooth geschikte externe 
apparaten zoals een MP3-speler, mobiele telefoon, enzovoort naar de speler 
overbrengen en vice versa.

Voordat u begint! -Als de speler via Bluetooth verbinding heeft gemaakt met 
een stereo-koptelefoon of mobiele telefoon, moet u om te beginnen de verbinding 
uitschakelen. Zorg ervoor dat het Bluetooth-apparaat dat u gaat gebruiken, gereed 
is voor koppelen. (raadpleeg de gebruiksaanwijzing van het apparaat). 
Controleer of het Bluetooth-apparaat het overbrengen van bestanden ondersteunt. 
(raadpleeg de gebruiksaanwijzing van het apparaat). 

Een extern apparaat op de speler registreren
(U hoeft dit product slechts één keer te registreren)
1. Tik op het pictogram  in het hoofdmenu.

Het venster voor het instellen van Bluetooth wordt 
weergegeven.

2. Tik op <Yes> (Ja).
De <Bluetooth Mode> is ingesteld op <On> (Aan).
Het pictogram  licht op.

3. Maak het externe apparaat gereed voor 
koppeling.

Raadpleeg de gebruikershandleiding van het apparaat 
voor meer informatie over hoe u het apparaat 
gereedmaakt voor koppeling.

4. Selecteer <File Transfer> (Bestandsoverdracht) en tik erop.
5. Tik op het pictogram [ ].

Deze speler zoekt automatisch naar Bluetooth-apparaten, ook als er niet op 
het pictogram [ ] is gedrukt.
Het te registreren apparaat wordt in de lijst opgenomen.
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BESTANDEN OVERBRENGEN NAAR/VAN EEN 
BLUETOOTH-APPARAAT (Vervolg)

Een extern apparaat op de speler registreren (vervolg)
6. Tik op de naam van het apparaat dat u wilt 

registreren.
Het venster voor het invoeren van het wachtwoord 
wordt weergegeven als het wachtwoord voor het 
externe apparaat anders is dan 0000. Raadpleeg 
de handleiding van het externe apparaat voor het 
wachtwoord.

7. Voer het wachtwoord in wanneer op het externe 
apparaat het invoervenster voor het wachtwoord 
wordt weergegeven.

Voer hetzelfde wachtwoord in als bij stap 6 hierboven.

Nadat het koppelen is voltooid, wordt het scherm Bestandsoverdracht 
weergegeven.

Zie stap 3 op pagina 124 om bestanden van de speler over te brengen naar 
een extern apparaat.

De cijfers van het wachtwoord kunnen variëren, afhankelijk van het externe 
apparaat. (Raadpleeg de gebruiksaanwijzing van het apparaat.)
Sommige functies werken mogelijk niet goed als u een ander Bluetooth-
apparaat dan de YP-P2 gebruikt voor het overbrengen van bestanden.

File Transfer

Samsung YP-P2

OPMERKING
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BESTANDEN OVERBRENGEN NAAR/VAN EEN 
BLUETOOTH-APPARAAT (Vervolg)

Een bestand van de speler naar het externe apparaat 
overbrengen

Voordat u begint! - Als u het externe apparaat niet kunt vinden waarmee u 
verbinding wilt maken,moet u het toestel eerst op de speler registreren. Zie 
pagina 122. Zorg ervoor dat het Bluetooth-apparaat dat u gaat gebruiken, 
gereed is voor koppelen. (raadpleeg de gebruiksaanwijzing van het apparaat) 

1. Selecteer <File Transfer>
(Bestandsoverdracht) in het scherm Bluetooth.

2. Selecteer een extern apparaat waarmee u een 
verbinding wilt maken en tik erop.

Nadat het verbinden is voltooid, wordt het scherm 
Bestandsoverdracht weergegeven. 

3. Selecteer de gewenste map en tik op <OK>.

4. Selecteer een over te dragen bestand en tik op 
<OK>.

Het geselecteerde bestand wordt overgebracht naar 
het externe apparaat.

Nadat de bestandsoverdracht is voltooid, tikt u op het pictogram [ ] om 
de modus voor bestandsoverdracht te sluiten. Zie pagina 125.
DRM-bestanden (beveiligbaar) kunnen niet op de speler worden afgespeeld.
De verbinding kan worden uitgeschakeld wanneer u speler of het 
externe apparaat uit- en weer inschakelt.Als dat het geval is, herhaalt u 
bovenstaande stappen om de verbinding opnieuw tot stand te brengen.

Voorbeeld: scherm 
<File Transfer> 
(Bestandsoverdracht)
van de speler

OPMERKING

OK

Video
Music

Playlists

Pictures

Datacasts

Texts

Games

Received Files

File Transfer 1/8



Bluetooth gebruiken _ 125

BESTANDEN OVERBRENGEN NAAR/VAN EEN 
BLUETOOTH-APPARAAT (Vervolg)

De bestandsoverdracht annuleren

Tik tijdens de overdracht op <Cancel> (Annul.).
De bestandsoverdracht wordt gestopt.

De bestandsoverdrachtmodus afsluiten.

1. Houd in het scherm met de bestandslijst het pictogram [ ] kort 
ingedrukt.

Telkens wanneer u op het pictogram [ ] tikt, keert de speler terug 
naar het vorige scherm en ziet u het venster voor het afsluiten van de 
bestandsoverdracht.

2. Tik op <Yes> (Ja).
De bestandsoverdrachtmodus wordt afgesloten.
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BESTANDEN OVERBRENGEN NAAR/VAN EEN 
BLUETOOTH-APPARAAT (Vervolg)

Een bestand van het externe apparaat naar de speler 
overbrengen
Als u een extern bestand naar de speler wilt overbrengen, moet u het 
eerst voorbereiden voor het koppelen.

Voordat u begint! - Als de speler via Bluetooth verbinding heeft gemaakt 
met een stereo-koptelefoon of een GSM, moet u eerst de verbinding 
uitschakelen.
Zorg ervoor dat het Bluetooth-apparaat dat u wilt aansluiten, gereed is voor 
koppelen. (raadpleeg de gebruiksaanwijzing van het apparaat)
Controleer of het Bluetooth-apparaat de bestandsoverdrachtfunctie 
ondersteunt.
(Raadpleeg de gebruikshandleiding van het apparaat.)
Selecteer <Discoverable> (Zichtbaar) in <Bluetooth Settings> (Bluetooth 
Instellingen)  <Discover Option> (Optie-ontdekking). Zie pagina 128.

1. Tik op het pictogram  in het hoofdmenu.
Het venster voor het instellen van Bluetooth wordt weergegeven.

2. Tik op <Yes> (Ja).
De <Bluetooth Mode> is ingesteld op <On> (Aan).
Het pictogram  licht op.
U kunt een bestand van het externe apparaat naar de speler overbrengen.
Raadpleeg de gebruikshandleiding van het apparaat om het externe 
apparaat te koppelen met en over te dragen naar de speler.
Bestanden die naar de speler zijn overgebracht, worden opgeslagen in de 
map <File Browser> (Bestandsbrowser)  <Received Files> (Ontvangen 
bestanden).
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HET BLUETOOTH-MENU GEBRUIKEN
De verbinding met het Bluetooth-apparaat verbreken

1. Tik op het pictogram  in het hoofdmenu.

2. Klik op het pictogram [ ].
Het menu <Bluetooth> wordt weergegeven.

3. Tik op <Disconnect> (Afsluiten).
Het bevestigingsvenster voor het verbreken van de 
verbinding wordt weergegeven.

4. Tik op <Yes> (Ja).
Het aangesloten apparaat wordt losgekoppeld.

Het verbonden Bluetooth-apparaat controleren

1. Tik op het pictogram  in het hoofdmenu.

2. Klik op het pictogram [ ].
Het menu <Bluetooth> wordt weergegeven.

3. Klik op <Connected Device> (Verbonden 
apparaat).

Er wordt informatie over het aangesloten apparaat 
weergegeven.

U kunt de verbinding van het verbonden apparaat 
alleen verbreken of het verbonden apparaat 
alleen controleren wanneer een Bluetooth stereo-
koptelefoon of GSM is aangesloten.

Bluetooth

Stereo Headset

Mobile Phone

File Transfer

Bluetooth Mode

Bluetooth Settings

Disconnect

Connected Device

Bluetooth

Stereo Headset

Mobile Phone

File Transfer

Bluetooth Mode

Bluetooth Settings

Disconnect

Connected Device

OPMERKING
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BLUETOOTH-INSTELLINGEN
Voordat u begint! - Stel de <Bluetooth Mode> in op <On> (Aan).

1. Tik op het pictogram  in het hoofdmenu.
2. Selecteer <Bluetooth Settings> (Bluetooth Instellingen) 

en tik erop.
Het menu <Bluetooth Settings> (Bluetooth Instellingen) wordt 
weergegeven.

3. Stel uw voorkeuren in en tik op <OK>.

Opties voor Bluetooth-instellingen
Discover Option (Optie-ontdekking) : U kunt instellen dat het Bluetooth-
apparaat deze speler herkent. Als u <Discoverable> (Zichtbaar) instelt, wordt 
de speler herkend en als u <Non-Discoverable> (Onzichtbaar) instelt, wordt de 
speler niet herkend.
Search Timeout (Zoek Timeout) : U kunt selecteren hoe lang er naar een 
nieuw apparaat wordt gezocht. Na het instellen van een tijd, wordt er naar een 
nieuw apparaat gezocht gedurende de tijd die u hebt ingesteld. U kunt kiezen uit 
<10sec>, <20sec>, <30sec>, <45sec> en <60sec>.
Delete Device (Apparaat verwijderen) : U kunt de registratie van een apparaat 
uit de speler verwijderen. Tik op het pictogram [ ] om alle geregistreerde 
apparaten te verwijderen. Zie pagina 129.
My Device Info. (Mijn Apparaat Informatie) : U kunt de naam en het adres van 
uw speler nagaan.

Bluetooth

Stereo Headset

Mobile Phone

File Transfer

Bluetooth Mode

Bluetooth Settings
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BLUETOOTH-INSTELLINGEN (Vervolg)
Een Bluetooth-apparaat verwijderen
1. Selecteer <Delete Device> (Apparaat Verwijderen) 

en tik erop.
De lijst van geregistreerde apparaten wordt weergegeven.

2. Selecteer een te verwijderen apparaat en tik op het 
pictogram [ ].

Tik op het pictogram [ ] om alle geregistreerde 
apparaten te verwijderen.

3. Tik op <Yes> (Ja).
Het geselecteerde apparaat wordt verwijderd.

Een Bluetooth-apparaat hernoemen
1. Selecteer <My Device Info.> (Mijn Apparaat 

Informatie) en tik erop.
Het scherm Mijn Apparaat Informatie wordt weergegeven.

2. Klik op het pictogram [ ].
Het venster Edit Device Name (Wijzig Apparaatnaam) 
wordt weergegeven.

3. Hernoem het apparaat door op het nummer- of teken 
pictogram te tikken.

[1Aa] : De invoermodus schakelt over van cijfers naar 
Engels met hoofdletters en Engels met kleine 
letters.

[ ] : U kunt de tekens één voor één wissen.
[ – ] : U kunt een spatie tussen tekens plaatsen.

U kunt het volgende invoegen: ‘–‘.
[OK] : Hiermee bevestigt u de wijziging.
Als u bijvoorbeeld ‘YPS5’ wilt invoeren:
-Ga naar het overeenkomstige toetspictogram en tik erop.

(één keer) (drie keer) (één keer) (drie keer) 
(twee keer) (één keer)

Bluetooth Settings

Discover Option

Search Timeout

Delete Device

My Device lnfo.

My Device Info.

Edit Device Name
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problemen oplossen
Als u problemen ondervindt met uw nieuwe MP3-speler, vindt u mogelijk een 
oplossing in deze lijst. Als het probleem zich blijft voordoen, kunt u contact 
opnemen met het dichtstbijzijnde Samsung Customer Service Center.

PROBLEM OPLOSSING

Kan de speler niet 
inschakelen.

• De speler kan niet worden ingeschakeld als de 
batterij helemaal leeg is. Laad de batterij op en 
schakel de speler nogmaals in.

• Druk met een scherp voorwerp de resetopening in.

De toetsen werken niet.

• Controleer of de schakelaar  in de richting 
van de pijl is geduwd.

• Controleer of u op de juiste knop of het juiste 
pictogram drukt.

• Druk met een scherp voorwerp de resetopening in.

Het scherm wordt niet 
ingeschakeld.

• Het scherm is in vol zonlicht mogelijk niet goed 
zichtbaar.

• Als <Display Off> (Display Uit) is geselecteerd in 
<Settings> (Instellingen) <Display> (Weergave), 
wordt het aanraakscherm uitgeschakeld. 
Tik op een willekeurige knop of op het scherm en 
wacht of het scherm aangaat.

De speler wordt 
uitgeschakeld.

• Controleer de batterijstatus.
• De speler wordt automatisch uitgeschakeld wanneer 

de batterij helemaal leeg is. Laad de batterij op.
• Als u <Auto Power Off> (Autom. Uitschakelen) 

selecteert via <Settings> (Instellingen) <System>
(Systeem), zal de speler in de pauzestand worden 
uitgeschakeld. Schakel de speler in.
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PROBLEM OPLOSSING

De levensduur van 
de batterij verschilt 
met de levensduur die 
is aangegeven in de 
gebruiksaanwijzing.

• Hoelang de batterij meegaat kan variëren, 
afhankelijk van de geluids- en scherminstellingen.

• Wanneer de speler langdurig wordt blootgesteld 
aan lage of hoge temperaturen, kan dit ten koste 
gaan van de levensduur van de batterij.

Storingen in de werking 
van EmoDio

• Controleer of uw computer voldoet aan de minimum 
systeemvereisten.

Kan geen verbinding 
met de computer 
maken.

• Controleer of de USB-kabel juist is aangesloten en 
probeer het nogmaals.

• Klik op <Start> op het bureaublad van de computer 
om Windows Update uit te voeren. Selecteer 
Essentiële updates en Service packs en installeer 
alle updates. Start de computer opnieuw op en sluit 
de speler opnieuw aan.

De overdrachtssnelheid 
van bestanden is te 
laag.

• De overdrachtssnelheid is lager als u meerdere 
programma’s, waaronder <EmoDio>, op uw 
computer uitvoert. Sluit overbodige programma’s af 
en probeer het nog eens.

De speler speelt niet af • Controleer of het beschikbare bestand is 
opgeslagen in het geheugen.

• Controleer of het muziekbestand is beschadigd.
• Controleer of de batterij voldoende is opgeladen.

Het uploaden van 
bestanden werkt niet.

• Controleer of de USB-kabel goed is aangesloten. 
Sluit deze zonodig opnieuw aan.

• Controleer of het geheugen vol is.
• Druk met een scherp voorwerp de resetopening in.
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PROBLEM OPLOSSING
Er ontbreken bestanden 
of gegevens.

• Controleer of de USB-kabel is losgeraakt tijdens de 
bestandsoverdracht. Dit kan overigens niet alleen leiden 
tot ernstige beschadiging van de bestanden/gegevens, 
maar ook van het product. Let goed op, want Samsung is 
niet aansprakelijk voor gegevensverlies.

Abnormale afspeeltijd 
tijdens het afspelen.

• Controleer of het bestand een VBR-indeling (Variable 
Bit Rate) heeft.

Abnormale weergave 
van bestandsnaam.

• Ga naar <Settings> (Instellingen) <Language>
(Taal(Language)) <Contents> (Inhoud) in het 
hoofdmenu om de juiste taal in te stellen.

Het product wordt 
warm.

• Er komt tijdens het opladen wat warmte vrij. Dit heeft geen 
invloed op de levensduur of functies van het product.

Er wordt een melding 
weergegeven tijdens het 
bekijken van een video.

• Probeer de videoclip nogmaals te downloaden met 
EmoDio.

Bluetooth-verbindingen
konden niet tot stand 
worden gebracht.

• Controleer of de stereo-koptelefoon geschikt is voor Bluetooth. 
Handsfree mono-koptelefoons worden niet ondersteund.

• De Bluetooth-verbinding kan worden uitgeschakeld als u 
de speler of stereokoptelefoon uit- en inschakelt. Probeer 
in dit geval opnieuw verbinding te maken.

• Als u op uw mobiele telefoon een gesprek wilt voeren, 
moet u controleren of u de Bluetooth-verbinding tussen de 
speler en de stereo-koptelefoon hebt uitgeschakeld.

• Als u op uw mobiele telefoon een gesprek wilt voeren, moet u 
controleren of u de speler hebt ingesteld op <Discoverable>
(Zichtbaar) onder <Bluetooth Settings> (Bluetooth 
Instellingen) <Discover Option> (Optie-ontdekking). Als 
<Non-Discoverable> (Onzichtbaar) hebt geselecteerd, kunt 
u de speler niet vinden op uw mobiele telefoon.
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bijlage
OVERZICHT VAN MENUOPTIES
Hier vindt u een overzicht van de structuur van de menu’s en functies op uw 
nieuwe MP3-speler.

Het selectievenster Menu

Videos Music Pictures FM
Radio Datacasts Prime

Pack
File

Browser Bluetooth Settings

Texts Stereo
Headset Menu Style

Games Mobile
Phone Sound

Alarm File Transfer Display

Calendar Bluetooth
Mode Language

Address Book Bluetooth
Settings Time

World Clock System

Calculator

Record

Subway
Route Map
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PRODUCTSPECIFICATIES

Model YP-P2
Classifi catie DC 5.0V / 500mA
Vermogen 
ingebouwde batterij 830 mAh / DC 3.7V 

Bestand
Compatibiliteit

GELUID : MPEG1/2/2.5 Layer3 (8kbps~320kbps, 
8kHz~48kHz), WMA (8kbps~320kbps, 
8kHz~48kHz)
AAC-LC (16kbps ~ 256kbps, 8kHz~48kHz)
AAC-Plus (16kbps ~ 256kbps, 
16kHz~44.1kHz)
Verbeterde AAC-Plus: (16kbps ~ 56kbps, 
32kHz~44.1kHz)

VIDEO : SVI (video: MPEG4; audio: MP3 (CBR 
44.1kHz 16bit Stereo, 128kbps); 
Resolutie: 480x272; framerate: 30fps) 
WMV9 (video: WMV9 Simple Profi le; audio: 
WMA9 (max. 860kbps); 
Resolutie: 320x240 of 480x272; framerate: 
30fps)

BEELD : JPG (alleen Baseline)
Uitgangsvermogen
oortelefoon 20mW/kan. (Frankrijk 5mW/kan.) (op basis van 16 )

Frequentiebereik 20Hz~20KHz
Signaal/ruisverhouding 89 dB bij 20 KHz LPF (gebaseerd op 1kHz 0 dB)

Afspeelduur
Maximaal 35 uur muziek afspelen (op basis van 
MP3 128kbps, volume 20, normale geluidsmodus), 
maximaal 5 uur video afspelen
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Temperatuurbereik 
voor gebruik -5~35°C (23~95°F)

Houder PMMA, roestvrij staal
Gewicht 86 g
Afmetingen (BxHxD) 52 X 100 X 9,95 mm

FM Radio
FM-frequentie 87.5~108.0MHz Totale harmonische 

vervorming FM 0.8%

Signaal-
ruisverhouding FM 59 dB Gevoeligheid FM 5dB

Draadloos systeem
Emissietype F1D
RF-stroomvoorziening 2.4mW
Zendfrequentie 2402MHz ~ 2480MHz
Ontvangstfrequentie 2402MHz ~ 2480MHz
Aantal kanalen 79 kan.
Temperatuur -10°C~ +50°C (14 ~ 122°F)
Modulatiesysteem GFSK
Communicatiemodus Semi-duplex communicatie
Vochtigheid 0~95%
Spec. ondersteunde versie 2.0
Module BCM2048

De inhoud van deze gebruiksaanwijzing kan ter verbetering zonder 
voorafgaande kennisgeving worden gewijzigd.
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LICENTIE
Op dit apparaat en de gebruiksaanwijzing rusten intellectuele eigendomsrechten 
en auteursrechten van derden. Het gebruiksrecht van de gelicentieerde inhoud 
is beperkt tot niet-commercieel gebruik door eindgebruikers. Commercieel 
gebruik hiervan is niet toegestaan. Het gebruiksrecht beperkt zich tot dit 
apparaat en strekt zich niet uit tot andere niet-gelicentieerde onderdelen 
of processen die voldoen aan ISO/IEC 11172-3 of ISO/IEC 13818-3 en die 
in combinatie met dit product gebruikt of verkocht zijn. De licentie beperkt 
zich tot het gebruik van dit product voor het encoderen en/of decoderen van 
geluidsbestanden die voldoen aan ISO/IEC 11172-3 of ISO/IEC 13818-3. 
Deze licentie houdt geen overdracht van rechten in voor producteigenschappen 
of -functies die niet voldoen aan ISO/IEC 11172-3 of ISO/IEC 13818-3.

CORRECTE VERWIJDERING VAN DIT PRODUCT 
(ELEKTRISCHE & ELEKTRONISCHE AFVALAPPARATUUR)
Dit merkteken op het product of het bijbehorende 
informatiemateriaal duidt erop dat het niet met ander 
huishoudelijk afval verwijderd moet worden aan het einde 
van zijn gebruiksduur. Om mogelijke schade aan het 
milieu of de menselijke gezondheid door ongecontroleerde 
afvalverwijdering te voorkomen, moet u dit product van 
andere soorten afval scheiden en op een verantwoorde 
manier recyclen, zodat het duurzame hergebruik van 
materiaalbronnen wordt bevorderd.
Huishoudelijke gebruikers moeten contact opnemen met 
de winkel waar ze dit product hebben gekocht of met de 
gemeente waar ze wonen om te vernemen waar en hoe ze 
dit product milieuvriendelijk kunnen laten recyclen.
Zakelijke gebruikers moeten contact opnemen met 
hun leverancier en de algemene voorwaarden van de 
koopovereenkomsten nalezen. Dit product moet niet 
worden gemengd met ander bedrijfsafval voor verwijdering.
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CORRECTE BEHANDELING VAN EEN GEBRUIKTE ACCU UIT 
DIT PRODUCT
(Van toepassing op de Europese Unie en andere Europese landen met 
afzonderlijke inzamelingssystemen voor accu’s en batterijen.)

Dit merkteken op de accu, handleiding of verpakking 
geeft aan dat de accu in dit product aan het einde van de 
levensduur niet samen met ander huishoudelijk afval mag 
worden weggegooid. De chemische symbolen Hg, Cd of 
Pb geven aan dat het kwik-, cadmium- of loodgehalte in 
de accu hoger is dan de referentieniveaus in de Richtlijn 
2006/66/EC. Indien de gebruikte accu niet op de juiste wijze 
wordt behandeld, kunnen deze stoffen schadelijk zijn voor 
de gezondheid van mensen of het milieu.

Ter bescherming van de natuurlijke hulpbronnen en ter 
bevordering van het hergebruik van materialen, verzoeken 
wij u afgedankte accu’s en batterijen te scheiden van 
andere soorten afval en voor recycling aan te bieden bij het 
gratis inzamelingssysteem voor accu’s en batterijen in uw 
omgeving.



Declaration of Conformity
For the following product:

YP-P2**, YP-P2J** / Digital Audio Player
(The mark “*” means the memory capacity and color of product.)

Manufactured at:
1. Samsung Electronics Huizhou Co., Ltd.

Industrial Complex, Chenjiang Town, Huizhou City, Guangdong Province, China
2. Tianjin Samsung Electronics Company.

300457, TSEC12, 4th Avenue, TEDA, Tianjin, China
3. Samsung Electronics Slovakia s.r.o.

Hviezdoslavova 807, 924 27 Galanta, Slovakia
4. P.T. Samsung Electronics Indonesia Co.

Cikarang Industrial Estate JI, Jababeka Raya Blok F 29-33 Cikarang. Bekasi 17530, Indonesia
(Factory name, address)

We hereby declare, that the product above is in compliance with the essential requirements of the 
R&TTE Directive (1995/5/EC) by application of:

EN 60065:2002
EN 55020:2002+A1:2003+A2:2005
EN 55022:1998+A1:2000+A2:2003
EN 55024:1998+A1:2001+A2:2003
EN 61000-3-2:2000
EN 61000-3-3:1995+A1:2001
EN 300 328-1 v1.7.1(2006-10)
EN 301 489-1 v1.6.1(2005-09)
EN 301 489-17 v1.2.1(2002-08)
Technical documentation kept at Samsung Electronics Co., Ltd. in Korea.

Manufacturer Representative in the EU:

Youn Doo Hyun / S. Engineer
Samsung Electronics Co., Ltd.
416,Maetan3-Dong, Yeongtong-Gu, 
Suwon-City, Gyeonggi-Do, Korea

August 20, 2007

Yong Sang Park / S.Manager
Samsung Electronics Euro QA Lab.
Blackbushe Business Park, Saxony Way, 
Yateley, Hampshire, GU46 6GG, United 
Kingdom

August 20, 2007
(Place and date of issue) (Name and signature of authorized person)
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Wanneer u suggesties of vragen heeft met betrekking tot Samsung producten,
gelieve contact op te nemen met de klantenservice van Samsung

Samsung Electronics Benelux BV
Voor Nederland:

0900-SAMSUNG (726-7864 € 0,10/Min)
www.samsung.com/nl

Voor België: 
02/201 24 18

www.samsung.com/nl


